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About This Guide

This guide is intended for SyteLine 9.00 and Infor CloudSuite users who also work in one or more 
Microsoft Office products and want to share information between Infor CloudSuite and the Office 
product.

Note: The latest version (9.01) of the Microsoft Add-Ins for Excel and Project is backwards 
compatible to version 9.00. Version 9.00 still had the name SyteLine. Beginning with 9.00.20, the 
name was changed to Infor CloudSuite. This document uses the Infor CloudSuite name throughout, 
but you can use it for those two add-ins with the 9.00 version of SyteLine. The Outlook add-in requires 
Infor CloudSuite 9.01.

Infor CloudSuite integrates with Microsoft Excel, Microsoft Outlook, and Microsoft Project. Each of 
these integrations requires some installation and configuration, which is described in the individual 
sections of this guide. 

The integration also includes a "search" Web service, so that you can search for related Infor 
CloudSuite data from any Office application’s Research task pane. This integration, which does not 
require any installation but does require registration of the service, is described in a section of this 
guide.

The requirements (prerequisites) for integration with each product are described in the appropriate 
sections.

Installation files
All of the files that are required to install these Office add-ins are included in the 
InforCloudSuiteOfficeIntegrations[version].zip file, where version is the latest version. You can 
download this file from our Product Download Center, which you can access through the 
InforXtreme.com support site. For instructions to install and configure each of the add-ins, see the 
appropriate chapter in this guide.
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 About This Guide 
Contacting Infor
If you have questions about Infor products, go to the Infor Xtreme Support portal at http://
www.infor.com/inforxtreme.

If we update this document after the product release, we will post the new version on this Web site. 
We recommend that you check this Web site periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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1Chapter 1: Excel-Based Toolset for 
Financial Reporting

This section describes how to install, set up, and use the Excel-based Toolset for Financial Reporting.

Requirements
 Microsoft Excel version 2010 or 2013.

 The latest Windows and Office Updates.

 Ability to connect to Infor CloudSuite ERP database server.

 The Period Sorting method 1 and 2 must exist in Infor CloudSuite ERP, and the Index is active for 
both.

 If you use the drill-down functionality and choose to have the data displayed in an Infor 
CloudSuite form, and a separate Infor CloudSuite session is open at the same time, you must 
have a concurrent license. If you don’t have a concurrent license, you can still operate in the 
given scenario if you have two User IDs; one for Infor CloudSuite and the other to use in the 
drilldown from Excel.

 Using Infor CloudSuite forms for drilldown is subject to certain conditions.  If you choose to show 
data in an Infor CloudSuite form, the forms that open are standard forms rendered on a Web 
Browser. This feature is available only when the Web Client framework is installed and configured 
on the utility/webserver. The add-in must know the details of the utility server, and this must be 
configured prior to using this feature. See the Infor CloudSuite Installation Guide for information 
on how to install and configure the Web Client.

Note: Drill-down data can be displayed on a new Excel Worksheet without the above drill-down 
requirements.

Recommendations
 Use absolute cell references instead of relative cell references for faster performance.
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 Turn off the automatic calculations for better performance. This is most important when using a 
large spreadsheet with lots of complex calculations. Press the F9 key in Excel to perform the 
calculations on demand when automatic calculations is off, or use CTRL+ALT+F9 to calculate all 
formulas in all open workbooks. To set the calculations to manual, choose Tools > Options and 
then click the Calculations tab. Set the calculation to Manual. See the help in Microsoft Excel for 
all recalculating options.

 Turn on caching and use populate cache whenever possible. This is a performance 
recommendation.

 Be careful when using cell references, especially as they relate to dates. For example, a cell may 
contain an actual value like "10/14/2016", which is formatted as "2016-10-14". When you use this 
cell as a reference in GL functions, Excel sends the actual value "10/14/2016" instead of the 
formatted value "2016-10-14".

List separator
The examples in this guide use a comma (,) as a list separator. You may be using a different 
character as a list separator. Excel uses the default list separator from your operating system’s 
Region and Language settings (the name of which is slightly different in different versions of 
Windows), and different areas of the world have different default list separators.

Install the Tool
Note: You may need administrator privileges to install the add-in.

This tool comes bundled with other Microsoft Office Add-Ins in a zip file. The zip file is named 
InforCloudSuiteOfficeIntegrations[version].zip.

1 Download the InforCloudSuiteOfficeIntegrations[version].zip file from the Product Downloads 
site. From within that zip file, copy InforCloudSuiteExcelAddIn.exe to the computer on which 
you want to use this tool. If you are installing into Excel 64-bit, copy 
InforCloudSuiteExcelAddIn64.exe. The computer to which you copy the file must be a client 
machine.
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2 Launch either InforCloudSuiteExcelAddIn.exe or InforCloudSuiteExcelAddIn64.exe 
depending on the criteria mentioned in step 1 above. The Infor CloudSuite Financial Reporting 
Tool Excel Add-In screen is displayed.

3 When asked whether to remove the installation files, read the instructions and select an option.

 The first option allows the setup to choose the folder where it will unpack the installation files. 
This can cause an error if you do not have appropriate permissions on the selected folder.

 The second option is recommended, because you can specify a folder that has appropriate 
permissions.

4 Click Next. The Welcome screen is displayed.
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5 Click Next. The Select Installation Folder screen is displayed.

6 Accept the default folder for installation or Browse to another folder.

7 Set the availability of the tool to just you or to anyone who has access to the computer it is being 
installed on.

8 Click the Disk Cost button to see the space available on all available drives.

9 Click Next. The Confirm Installation screen is displayed.

10 Click Next to start the installation.

11 When the installation is complete, the Installation Complete screen is displayed.

12 Click Close to close the wizard.

13 Check the installation folder that you chose earlier to ensure .dll files have been installed. Provide 
read-write permission to this folder. The add-in needs to create an XML file that is required for 
some functionality.

Setting up the Tool
Now that the tool is installed, you must set up the tool to work with your environment.

Note: If, after following the directions in this section, you notice that the Infor CloudSuite functions are 
not available, perform the following steps:

 Disable all third-party Add-ins (do NOT remove them) from Excel. Do not disable the Infor 
CloudSuite Add-in.
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 Close and restart Excel. You should now see the Infor CloudSuite functions.

 Enable the third-party Add-ins that you disabled.

1 Open Microsoft Excel.

2 Select the Infor CloudSuite menu.

Note: You must use your operating system’s uninstall process to remove the tool once it is 
installed.

The toolbar contains the following fields and buttons:

 Version Info: Click this button to see the version of the Infor CloudSuite Excel Add-In, the 
version of Infor CloudSuite that is compatible with this version of the Add-In, the version of 
Excel, and the version of Infor CloudSuite you are connected to (if you are connected).

 Site: Use this field to select the desired site.

 Period: Use this field to select the desired period. The period value shows the current period 
of the default site. You can change the period here. The default value is shown whenever you 
change the value in the site field.

 Year: Use this field to select the year. The year value shows the current fiscal year of the 
default site. You can change the year here. The default value is shown whenever you change 
the value in the site field.

 Query: This field lists all the possible queries. See the list below: 

Query Command Description

GET ALL CODES Returns all codes from the COA

GET ASSET CODES Returns all codes with type Asset

GET LIABILITY CODES Returns all codes with type Liability

GET REVENUE CODES Returns all codes with type Revenue

GET EXPENSE CODES Returns all codes with type Expense

GET EQUITY CODES Returns all codes with type Owner's Equity

GET CODES STARTING WITH Returns all codes staring with a given pattern
Example: GET CODES STARTING WITH 1005*

GET CODES ENDING WITH Returns all codes ending with a given pattern
Example: GET CODES ENDING WITH  *100

GET DESCRIPTION STARTING 
WITH

Returns all codes whose associated description start with the 
given pattern
Example: GET DESCRIPTION STARTING WITH Cash

GET DESCRIPTION ENDING 
WITH

Returns all codes whose associated description end with the 
given pattern
Example: GET DESCRIPTION ENDING WITH "Discount"

GET DESCRIPTION CONTAINS Returns all codes whose associated description contains a 
given pattern
Example: GET DESCRIPTION CONTAINS Inventory
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 ! Go - Use this button to execute your chosen query.

Note: If you select a query command that requires extra input, the Search String field displays 
as in this example:

 Setup: Click this button to set up your company information as detailed in the next step.

3 While viewing the Infor CloudSuite Add-In (on the Infor CloudSuite menu), click Setup and then 
Setup Company.

GET UNITCODE {1..4} FOR Returns unit codes for the given account
Example: GET UNIT CODE 1 FOR 102000   (Returns all the 
unit codes 1 for account code 102000)
GET UNIT CODE 4 FOR 504000 (Returns all the unit codes 
4 for account code 504000).

GET CURRENT ASSESTS Return all codes with Account Class 'Current Assets'

GET NONCURRENT ASSETS Return all codes with Account Class 'Noncurrent Assets'

GET CURRENT LIABILITIES Return all codes with Account Class 'Current Liabilities'

GET 
NONCURRENTLIABILITIES

Return all codes with Account Class 'Noncurrent Liabilities'

GET EQUITY(AC) Return all codes with Account Class 'Equity'

GET REVENUE Return all codes with Account Class 'Revenue'

GET COST OF SALES Return all codes with Account Class 'Cost of Sales'

GET OPERATING EXPENSE Return all codes with Account Class 'Operating Expense'

GET DEPRECIATION AND 
AMORTIZATION EXPENSE

Return all codes with Account Class 'Depreciation and 
Amortization Expense'

GET INTEREST INCOME 
EXPENSE

Return all codes with Account Class 'Interest Income 
Expense'

GET NON-OPERATING 
INCOME EXPENSE

Return all codes with Account Class 'Non Operating Income 
Expense'

GET TAX EXPENSE Return all codes with Account Class 'Tax Expense'

Query Command Description
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4 The Infor CloudSuite GL Setup window is displayed.

5 Click the Infor CloudSuite Connection tab.There are two ways to use the information on this 
tab. Either choose the Direct Connection option or the IDO Web Service option. 

 Direct Connection: If you select this option, the Direct Connection area of the window 
becomes enabled. Select this option if you plan to have a direct (non-web) connection to 
the database. If you choose this option, jump to step 6.

 IDO Web Service: If you select this option, the IDO Web Service area of the window 
becomes enabled. Select this option if you plan to use a URL to connect to the database. 
If you choose this option, jump to step 7. 

6 For the Direct Connection, provide the following information:

 Server Name: Enter the name of the server where the data you want to see resides. If you 
have an instance also, provide that with the following syntax - servername\instance.

 DB Name: Enter the database name that contains the data you want to see.

 User ID: Enter the user ID for the database.

 Password: Enter the password associated with the user ID you supplied.

7 For the IDO Web Service, provide the following information:

 End Point: This is the URL address of IDO Web service. Use the following syntax: http://
utilityorwebservername/IDORequestService/IDOWebService.asmx
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 Active Configs: This is a list of check boxes that displays all available configurations 
retrieved from the given End Point. This list may contain configuration for the test environment 
or multiple configurations pointing to the same Site.

You must select at least one configuration from the list. The selected Config(s) is used to 
retrieve the Site name that is available for selection from the Tool Bar within Excel.

 Default Config: This is the default site that is used when no Site name is explicitly provided 
as a parameter. You can select the Default Config from the drop-down list. This list is 
populated based on the selected items in the Active Config field.

 Use Workstation Login: Select this check box use use the workstation login. If selected, the 
Infor CloudSuite User ID and Password fields are disabled.

 Infor CloudSuite User ID: This is a valid Infor CloudSuite User ID.

 Password: This is the password for the Infor CloudSuite User ID you provided.

Note: In order to use the IDO Web Service, a SyteLine user must be assigned a 
SyteLineAutomation license. An Infor CloudSuite Industrial user must be assigned the 
Automation license. For more information about this license type, see the Infor CloudSuite 
Industrial Licensing guide.

On the Object Authorizations for User form in Infor CloudSuite, these privileges must be 
granted for any user who wishes to use the IDO web service.

 set Object Type to MIDDLEWARE

 set Execute Privilege to Granted

 set Read Privilege to Granted

 set Object Name for each of these (you have to do them one at a time): SLPertots, 
SLLedgers, SLPoVchs, SLInvItemAlls

8 Click the General tab.
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 Enable Logging - Select or clear the Enable Logging check box. Query execution details 
and error log, if any, are logged into the System Event Log if you check this check box. The 
event log is named "Infor Global Solutions - Infor CloudSuite", and the entries are logged with 
the source name "InforCloudSuiteGL Excel Add-Ins". Use Windows Event Viewer to access 
these logs.

In order to write to the event log, you must have the read and write permission in the registry 
for:

 HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\eventlog\Application

 HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\eventlog\Security

 HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\eventlog

Note: The Enable Logging should be enabled only for troubleshooting purposes. Turn it off when 
the troubleshooting is complete.

The Add-ins creates an Event Log one time and writes entries into the log when Event 
Logging is enabled. However, the event log creation may fail if you do not have administrator 
privileges to create one. So, we recommend that you run EXCEL in Admin mode at least once 
to create the Event Log. A standard user can read or write into an Event log unless there are 
special security settings that prevent doing so.

To run Excel in Admin mode:

a.Click the Windows Start Button.

b.Type "Excel".

c.Press SHIFT + CTRL + ENTER.

 Enable Caching: Select or clear the Enable Caching check box. If this field is cleared, 
caching is enabled only for the current session when activated by selecting 'Populate Cache' 
from the Toolbar menu. If you want to enable caching every time you work with GL functions, 
select this field.

 Web Service Client URL: If you plan to view drilldown details on an Infor CloudSuite form, 
enter the internet address of the Web Server where the Web Client is installed. The syntax is 
http://servername/WSWebClient/Default.aspx.

 Display inside the default Browser: Select this check box to display the Infor CloudSuite 
form in your default browser. If you clear this check box, the form is displayed as an 
embedded form in Excel.

 Image Location for Report Templates: Enter the name or browse to the name of the folder 
where you store images for the report templates. If you aren’t using the report templates, you 
can leave this field blank.
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9 If you plan to use the Chinese Reporting Pack, click the Reporting Pack tab; otherwise, skip to 
Step 13.

10 Select the Chinese Reporting Templates check box. You should also select the Standard 
Reporting Templates check box.

11 Select a default reporting pack from the drop down list.

12 Click OK.

13 Restart Excel after making any changes in the Infor CloudSuite GL Setup window.

Using the Tool
Now that the tool has been installed and set up, you can use it.

GL Helper

The GL Helper is a learning tool for beginning users that helps them become familiar with the way the 
Excel-Based Toolset for Financial Reporting tool works. It helps the user build formulas.

1 Click the GL Helper button on the Infor CloudSuite toolbar.
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2 The GL Function Helper screen is displayed.

3 Provide the following information:

 Chart of Account: The accounts in the two drop-down fields default from the from the site 
selected in the Site field. Choose the range of accounts. Select the Use Cell Reference 
check box to use the cell reference of the account code instead of the actual code; see 
example below.

 Parameters:

 Site: Select a Site from the drop-down. The default site comes from the Site selected from 
the Excel Toolbar. The Start Account Code, End Account Code, and Year fields are 
updated when you change the site.

 Period: Select the period that will be used in the formula

 Year: Select the fiscal-year that will be used in the formula
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 Use Dynamic Parameters: Select this check box to make the report more interactive by 
using the selectable parameters list. Period, Fiscal Year, and Site are added to the top of 
the spreadsheet, each with a selectable drop-down list; see example below.

 Selected Item(s): This area is divided into two panes. The left pane includes items that are 
NOT selected. The right pane includes items that ARE selected. You have to select an item 
and click one of the arrows (either pointing left or right) to get the item into the pane you want. 
By default, all items are in the left (unselected) pane. Move the items you want to be in the 
right (selected) pane.

Description of the items:

Item Description

Account Code Insert Account code as text.

Description Insert SLDESC function to retrieve the Account Name.  

Examples:

=SLDESC("10000")

=SLDESC(A1)

Period Balance Total Insert SLGL function to retrieve the period total for the 
selected Period and Fiscal Year.  

Examples:

=SLGL("10000",7,2011, "A")

=SLGL(A1, $B$1, $B$2, "A")

Period Budget Total Insert SLGL function to retrieve the Budget amount for the 
selected Period and Fiscal Year.  

Examples:

=SLGL("10000",7,2011, "B")

=SLGL(A1, $B$1, $B$2, "B")

Period Plan Total Insert SLGL function to retrieve the Plan amount for the 
selected Period and Fiscal Year.  

Examples:

=SLGL("10000",7,2011, "P")

=SLGL(A1, $B$1, $B$2, "P")

YTD Balance Total Insert SLGL function to retrieve the balance as of the 
selected Period and Fiscal Year.  

Examples:

=SLGLBAL("10000",7,2011, "A")

=SLGLBAL(A1, $B$1, $B$2, "A")
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4 Click the Generate button. The following is an example of the result.

Using COA Dimension

Use the COA Dimension feature to retrieve COA Dimension and attributes directly into Excel 
Worksheet. This feature is not available for customers on the Cloud or for any client useing IDO Web 
Services for back-end connection.

1 Click COA Dimension in the Infor CloudSuite toolbar.

YTD Budget Total Insert SLGL function to retrieve the Budget amount as of the 
selected Period and Fiscal Year.  

Examples:

=SLGLBAL("10000",7,2011, "B")

=SLGLBAL(A1, $B$1, $B$2, "B")

YTD Plan Total Insert SLGL function to retrieve the Plan amount as of the 
selected Period and Fiscal Year.  

Examples:

=SLGLBAL("10000",7,2011, "P")

=SLGLBAL(A1, $B$1, $B$2, "P")

Item Description
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2 This screen is displayed:

3 Specify:

 Account Code: The account code comes from the dimension subscriber table, so this drop-
down lists only those COA codes which have a dimension defined for it.

 Dimension: This is a list of dimensions associated with the selected account code.

 Site: Select a site. The Year field is re-populated when the site selection changes.

 Period: Select the period to be used to filter the dimension data.

 Year: Select fiscal year to be used in the filter.

4 Use the move buttons to add or remove desired selected attributes to the left panel.

5 Click Generate.

Using the Report Wizard

The Report Wizard is a simple step method used to generate various financial reports on the fly by 
using the GL function to retrieve data from the selected site.

1 Click Report Wizard in the Infor CloudSuite toolbar.
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2 This screen is displayed.

3 Provide this information:

 Select a Reporting Pack: Select either Standard or Chinese.

 Report Template: There are four financial report templates available for selection if you use 
the standard reporting pack. The templates are Balance Sheet By Type, Balance Sheet By 
Account Class, Trial Balance, and Profit and Loss Statement. Select the template that you 
want to use. There are also four financial report templates avalable for selection if you use the 
Chinese reporting pack. The templates are Income Statement, Balance Sheet, Statement of 
Cash Flow, and Statement of Changes in Equity Report. Select the template that you want to 
use.

 Site: Select a site. This default site name comes from the site selected on the Excel toolbar. 
The Year field is updated when the site changes.

 Period: Select the period that will be used in the formula.

 Year: Select the fiscal year that will be used in the formula.

 Currency: If you select a currency, the report is formatted to use the GL function with a 
currency parameter. The G/L balances are converted to the selected currency when the 
currency parameter is supplied to the function. The currency selection is not visible for the 
Chinese Reporting Pack or for the Trial Balance from the Standard Reporting Template.
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  FSB: This field provides a list of FSB names that is populated each time a different site is 
selected. Selection of FSB is optional. The primary GL is used when no FSB is selected.

 Use Dynamic Parameters: Select this check box to make the report interactive. When 
selected, Period, Year, and Site are added to the top of the report, each with a selectable 
drop-down list. Choose an option in the drop-down list, and the data in the report changes.

 Include Zero Balance: This check box does not display if using the Chinese Reporting Pack 
and Income Statement is selected as the report template. Otherwise, if this check box is 
cleared, the tool removes GL accounts that have zero balances for the selected period and 
fiscal-year. Select this check box if you want to include zero-balance accounts.

4 Click Generate. The report is generated. The following is an example of the Balance Sheet By 
Type report.
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Report Template Details

There are 4 report templates if you use the standard reporting pack: Balance Sheet by Type, Balance 
Sheet by Account Class, Trial Balance, and Profit and Loss Statement.

Balance Sheet by Type: This report, grouped by the Type column from the Chart of Accounts, has 
Account Code and the SLDESC function to retrieve the description, and either the SLGLBAL or the 
SLNGLBAL function to retrieve the balance amount. The Site, Period, and Year have a selectable 
drop-down list, so you can easily change the data that displays in the report. The difference between 
revenue and expenditure is added to the bottom of the Balance Sheet with a title of Estimated P/L. 
The argument value of the GL function uses absolute cell reference for Site, Period, and Year, and 
relative cell references for account code, when the Use Dynamic Parameters is checked in the Report 
Wizard. The estimated P/L is calculated using the End of Period rate.

Balance Sheet by Account Class: This report is the same as Balance Sheet by Type except that the 
grouping is performed based on Account Class.

Trial Balance: This report is set up with the use of an extra drop down list field on the Report Wizard. 
When you select Trial Balance as the Report Template, the Income Summary Account field is 
displayed.

This report is grouped by Account Class. It includes account codes with type Assets, Liabilities, 
Owners' Equity, Revenue and Expense. The closing amount, which may be already part of Retained 
Earnings, may cause a non-balanced debit and credit totals. To avoid this, the closing balance must 
be subtracted from the Retained Earnings account. Since the SL doesn’t keep the Income Summary 
account while performing the Year-end closing activities, the Add-in requires you to select the same 
prior to generating the Trial Balance. The Income Summary Account field only displays account 
codes with the type ‘Owners Equity’.

The closing summary amount is calculated as:
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SLPL(12, 2012, "OH", "Y") - SLPL(12, 2012, "OH", "N") 

Profit and Loss Statement: This report is set up with the use of an extra check box on the Report 
Wizard. When you select Profit and Loss Statement as the Report Template, the Use Expense-to-
Revenue check box is displayed.

If you select the Use Expense-to-Revenue check box, the period total and YTD total percentage is 
calculated by dividing an individual expense by total revenue. If this check box is cleared, the 
percentage is calculated by dividing an individual expense amount by total expense.

This report includes items from revenue and expenditure type accounts. You must assign the 
appropriate Account Class to your chart of accounts code to generate this statement. The report is 
formatted in the following order:

 Revenue and Group Total

 Cost of Sales and Group Total

 Gross Profit. Calculated : Revenue - COS

 Operating Expense and Group Total

 Profit from Operations. Calculated: GP - Operation Total

 Interest Income Expense and Group Total

 Non-Operating Income Expense and Group Total

 Depreciation and Amortization Expense and Group Total

 Profit before Tax Expense. Calculated: GP - Total Expense (without Tax)

 Tax Expense and Group Total

 Net Profit Calculated: GP - Total Expense
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Here is an example of the Profit and Loss Statement:

There are four report templates if you use the Chinese reporting pack: Income Statement, Balance 
Sheet, Statement of Cash Flow, and Statement of Changes in Equity Report. The main content of the 
Chinese reports consists of the Reporting Group, Sequence Number, Amount columns that show the 
current month as well as the cumulative amount.

Income Statement (CRP only): This is an income statement report. It includes the Company Name, 
Site Name, Day, Month, Year of the statement, and the name of the person who prepared this 
statement. Initially, this report is generated with no balance amount. That's because the Reporting 
Group definition has no account code associated with it. Once the report is rendered on a worksheet, 
you can right click on each Reporting Group and assign account codes from the Add To Reporting 
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Group form. This is a one-time setup, and you can modify the grouping when needed.Here is a 
sample:

Balace Sheet - CRP (CRP only): This report is grouped by the Type and Account Class column from 
the Chart of Accounts. It is formatted using the Excel functions, SLDESC to retrieve description and 
SLGLBAL function to retrieve the balance amount. The Site, Period and Year are choices in the drop-
down list, so the report can be viewed for different periods.

Statement of Cash Flow: The Statement of Cash Flow shows the actual cash collected and paid by 
using inflow and outflow.

The Statement of Cash Flow has these three sections:

 Operating Activities

 Investing Activities

 Financing Activities

The columns headers in the report are: Item, Line No, Subtotal, and Cumulative. The report template 
is formatted using the SL GROUPING functions such as SLGRPDESC, SLGRPGLBAL, 
SLGRPGLYTDBAL and SLNGRPGLYTDBAL. Initially, the report is rendered without any balance; 
that is because there is no COA associated with any group definitions. Once the template is 
generated, you can add COA to each group. You can modify the group definition to suit your 
requirement.

Most of the inflow and outflow balances are derived after adding or subtracting certain Balance Sheet 
items. In this case, an increase or decrease in current year balance is calculated by comparing with 
the previous year balance. The columns that retrieve previous year and current year balance to 
calculate the difference are hidden.
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This table shows the addition or subtraction of differences to Inflow and Outflow total:

Increase Decrease

Asset Outflow Inflow

Liabilities Infow Outflow

Equity Inflow Outflow
Infor CloudSuite Industrial - Microsoft Office Integration User Guide | 31



  
Cash Flows from Operating Activities Using the Direct Method

Line Item Description

Sales of goods or services 
received in cash

Type: Inflow

Sales +- (add or subtract) A/R difference - Bad Debt Expenses

Line 1 : Net Sales = YTD Sales (SLNGRPGLYTDBAL)

Line 2: A/R Difference = Previous Year A/R 
Balance(SLGRPGLBAL)  - Current Year A/R Balance 
(SLGRPGLBAL) 

If difference is + amount (means decrease in AR) then amount is 
added to the inflow.

If difference is - amount (means increase in AR) then amount is 
subtracted from the inflow.

Prev. Year Current Year Result (Prev-Curr) Effect

100 80 +20 Inflow. 

Added to
Sales

70 100 -30 Outflow.
Subtracted
from Sales

Line 3: Bad Debts = Total bad debts expenses(P/L)

Cash Received from Other 
Operating Activities

Type: Inflow

Other Income +- Income Receivable difference

Line 4: Other Income = Income Accounts excluding Sales.

Line 5: Difference Income Receivable : Previous Year Balance(B/
S)  - Current Year Balance (B/S) 

If difference is + amount (means decrease in Income Receivable) 
then amount is added to the inflow.

If difference is - amount (means increase in Income Receivable) 
then amount is subtracted from the inflow.

Refunds of taxes

Type: Inflow

Line 6 : Tax Refund Account

Interest Income

Type: Inflow

Line 7: Interest Income

Other operating cash 
receipts

Type: Inflow

Line 8: Other Cash Receipt
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Purchase of goods and 
services paid by cash

Type: Outflow

COG+- Difference Inventory - Difference A/P

Line 9: COG = Cost of Goods Sold 

Line 10: Difference Inventory =  Current Year Balance(B/S) - 
Previous Year(B/S)

If difference is + amount (means increase in Inventory) then 
amount is added to the COG.

If difference is - amount (means decrease in Inventory) then 
amount is subtracted from the COG.

Current Year  Prev. Year Result (Curr-Prev) Effect

100 80 +20 Outflow.
Added to
COG

70 100 -30 Inflow.
Subtracted
from COG

Line 11: A/P  =  Previous Year (B/S) - Current Year (B/S)

If difference is + amount (means decrease in A/P) then amount is 
added to the COG.

If difference is - amount (means increase in A/P) then amount is 
subtracted from the COG.

Prev. Year Current Year Result (Curr-Prev) Effect

100 80 +20 Outflow.
Added to
COG

70 100 -30 Inflow.
Subtracted
from COG

Cash Payments for

Operating Expenses

Type: Outflow

Total Operating Expenses +- Accrued Liabilities difference

Line 12: Total Operating Expense=Expense type accounts 
excluding Bad Debt Expenses and Depreciation

Line 13: Accrued Liabilities =  Previous Year - Current Year 

Prev. Year  Current Year Result (Curr-Prev) Effect

100 80 +20 Outflow.
Added to
Operating
Expenses 

70 100 -30 Inflow.
Subtracted
from
Operating
Expenses

Line Item Description
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The Add-In finds the previous fiscal-year by using the current fiscal year definitions. The end-period of 
the previous fiscal-year is retrieved from the period table.

Financing and Investing sections have total inflow and outflow which is added to the total Inflow and 
Outflow at the end.

Statement of Changes in Owner's Equity Report (SOCE): The SOCE statement shows the 
increase and decrease in the owner's equity.

Paid to and for employees

Type : Outflow

Line 14: Employee Expenses

Cash Paid for Interest Line 15: Interest Expense

Cash Paid for Taxes

Type : Outflow

Tax Expense +- Difference Accrued Taxes Payable

Line 16: Tax Expense:  YTD Tax Expense total (P/L)

Line 17: Accrued Taxes Payable =  Previous Year - Current Year 

Prev. Year  Current Year Result (Curr-Prev) Effect

100 80 +20 Inflow.
Added to Tax
Expense

70 100 -30 Outflow. 
Subtracted
from Tax
Expense

Other Payment

Type : Outflow

Line 18: +/- Other Expense

Description Retrieved using the SLGRPDESC function

Line No A sequence number

Share Capital Record the opening balance and subsequence changes in 
the share capital

Capital Reserve Record the opening balance and subsequence changes in 
the capital reserve

Surplus Reserve Record the opening balance and subsequence changes in 
the surplus reserve

Reserve

Undistributed Profit Record the opening balance and subsequence changes in 
the undistributed profit

Treasury Shares Record the opening balance and subsequence changes in 
the treasury shares

Total owners' equity Calculate the total 

Line Item Description
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This table shows line items:

Reporting Group

A Reporting Group is collection of COA Codes and related Unit Codes that precisely define a subset 
of real data. This high-level data model can be used along with other parameters such as Period, 
Fiscal Year, etc. to retrieve summary balance amount for generating various financial statements, 
KPIs etc.

The Reporting Group definition is stored in a file and placed in a folder where the Add-In assembly is 
located. The local user may require read and write permission on this folder. The definition file is a 
simple XML file named "InforCloudSuiteGLReportGroup.XML". If you want to share your XML file with 
other people in the same company, simply copy the XML file and place it in the same folder where the 
Add-in is installed. You can find the Assembly location from the Infor CloudSuite Add-In Information 
window which can be opened from the Add-Ins Ribbon.

Line No. Description Details

1 Balance at the end of 
last year

The balance from the previous year is 
calculated using the function SLGLGRPBAL. 
The end-period of previous fiscal year is 
used.

2 Changes in accounting 
policies

The balance is added to the undistributed 
profit

3 Prior period errors The balance is added to the undistributed 
profit

4 Profit for the year The balance is added to the undistributed 
profit

5 Other The balance is added to the undistributed 
profit

6 Owner Capital 
investment

The balance is added to the share capital

7 Repurchase of treasury 
shares

The balance is added to the treasury shares

8 Allocated to the owners 
(shareholders)

The balance is added to the share capital

9 Transfer to surplus 
reserve

The balance is added to the surplus reserve

10 Capitalizing of capital 
reserves

The balance is added to the capital reserve

11 Capitalizing of surplus 
reserves

The balance is added to the surplus reserve

12 Surplus reserves make 
up losses

The balance is added to the surplus reserve
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The following is an example of Report Group "COG" and the Excel function SLGRPBAL that retrieve 
the sum of the balance amount of accounts code that is grouped under "COG".

To define a reporting group

1 Select Tools > Reporting Group > New Reporting Group. The Reporting Group form is 
displayed.

2 Provide the following information:

 Group Name: Enter a unique group name. The maximum character allowed is 100.

 Description: Enter a Description for the group. The maximum character allowed is 240. This 
description can be retrieved by using the Excel function =SLGRPDESC() by passing the 
Group Name as an argument.

3 Click Save.
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The example below shows the Excel function used to retrieve the Group Description.

To add to a reporting group

There are three different methods you can use to assign COA codes to a Reporting Group.

 Method 1: Select a cell or multiple cells that have Excel functions SLDESC, SLGL, SLGLBAL, 
and SLGLTRAN, then right click to access Add to Reporting Group menu.

Method 1 Example

1 Generate a Trial Balance Template including zero balance account.

2 Select one or more cells that contain the related accounts.

3 Right Click and select Add To Reporting Group.

4 From the Add To Reporting Group window, select an appropriate Group name. Click New 
Group Name to add a new group.

5 Click Apply to keep the changes.

OR

 Method 2 (Modifying): Modify the existing definition using this method.

Method 2 Example

1 Select a cell that has an Excel Function SLGRPDESC, SLGRPGL, and SLGPGLBAL.

2 Right click and choose Modify Reporting Group. The Add To Reporting Group window opens.
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3 Make any changes you wish and click Apply to keep the changes.

OR

 Method 3: Use the Add to Reporting Group form from the Tools Menu.

Method 3 Example

1 Select Tools > Reporting Group > Add to Reporting Group.

2 Select a Group Name.

3 Click New to add a new code. The code and Unit 1 to Unit 4 components are enabled so you can 
enter new values.

4 Select a code from the dropdown or enter a code directly into the column below. The add-in does 
not validate the code entered manually. Invalid codes are ignored when retrieving the data.

How to use the Reporting Group:

=SLGRPDESC("COG") retrieves the description "Cost of Goods Sold"  and 
=SLGRPGLBAL("COG") retrieves the total amount of all the COA codes defined under this group. 
See SLGRPDESC and SLGRPGLBAL functions for more details.

5 Click Save to keep the changes.
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Images for Report Templates

The header part of the reports is formatted with an image. By default, the image looks like this (Trial 
Balance used as an example):

You can use your own images to format each report. There are four images that are part of the 
standard reporting pack and two that are part of the Chinese reporting pack. To format the report with 
custom images:

1 Create images in PNG format and place them in a folder.

The images (for the standard reporting pack) must be named exactly as follows:

 Balance Sheet By Account Class.png

 Balance Sheet By Type.png

 Trial Balance.png

 Profit and Loss Statement.png

The images (for the Chinese reporting pack) must be named exactly as follows:

 Income Statement CRP.png

 Balance Sheet CRP.png

2 From the General tab of the Infor CloudSuite GL Setup dialog, enter or select the name of the 
folder where the images are stored.

Caching (optional)

Caching is an option to optimize the performance of Excel calculation of the Infor CloudSuite GL data. 
It's a memory-based output caching where the data result returned from the server is stored in the 
memory for reuse when an Excel GL function requests the same data again.

The cache can be cleared and refreshed anytime, and it clears automatically when you shut down the 
Excel Application.

Enable Cache

When caching is enabled, the Excel GL functions look for data in the cache prior to searching the 
database. Data is retrieved from the database only when no data is found in the cache. The data is 
then added to the cache for future use. 

You can enable the caching feature in two ways:

 By selecting Enable Caching on the General tab of the Infor CloudSuite GL Setup window as 
shown in step 8 on page 19 (this way enables caching every time you work with GL functions) or
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 By selecting Populate Cache from the Tools menu. This option generates cache much faster 
than individual function caching. It consolidates a number of GL functions as a batch and 
retrieves the data from the database. This reduces the number of round-trips to the database, 
improving performance.

Clear Cache

To clear the cache, select Clear Cache from the Tools menu.

Drilldown

Functions SLGL, SLNGL, SLGLBAL, SLNGLBAL, SLGLTRAN and SLNGLTRAN have the drilldown 
feature enabled. This feature enables you to navigate into informative accounting journals. You can 
right-click on an Excel cell that contains one of the above formulas and choose how to drilldown. You 
can also use the Drilldown menu on the toolbar.

You can drilldown in two different ways.

 choose to display transaction details on a new work sheet OR

 open the Infor CloudSuite G/L Posted Transaction form in a new window that displays the 
transaction details. The details are filtered based on the argument values extracted from the 
Excel formula.

1 Drilldown using either the right-click method or the toolbar.

 If you use the Drilldown button on the toolbar, click in the cell you want to drilldown and click 
Drilldown.

 If you want to right-click on the cell, right-click and choose Drilldown: What makes up this 
number?
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 In either case, you are given two options: Show me in a new Worksheet or Show me in an 
Infor CloudSuite form. See the example below about how the two options are rendered:

New Worksheet Details

When you choose Show me in a new Worksheet, a new Worksheet is added to the existing 
Workbook each time you choose this option.

The following columns headers are included:

 Sequence

 Account Code

 Unit Code 1- 4

 Date

 Amount (Domestic)

 Reference

 Cust/Vendor

 Invoice/Voucher

 Invoice/Vch Seq

 Check#
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 Check Date

 Bank Code

Infor CloudSuite Form Details

When you choose Show me in an Infor CloudSuite form, a new Excel Window is opened to host an 
Infor CloudSuite form each time the drilldown option is selected. The G/L Posted Transactions form 
is used when the "Actual" argument is used. The Chart of Accounts Budget and Plan form is used 
when the "Budget" or"Plan" argument is used.

Drilldown to Purchase Order Receipt and Invoice from Ledger

Further drilldown is allowed from the Journal entries to the source transactions such as Purchase 
Order Receipt and Sales Invoice.

The Invoice/Voucher number is bold and underlined if further drilldown is allowed. You are presented 
with a Purchase Receipt or Invoice (depending upon the type of transactions) context menu, when 
you right-click on this cell.

The following graphic shows the drilldown journals that can be further drill downed (Purchase Receipt 
in this case).

For Purchase Receipt, the following column headers are included:

 PO#

 PO Line

 PO Release

 Item

 Item Description

 Received Date
42 | Infor CloudSuite Industrial - Microsoft Office Integration User Guide



 

 Qty Vouchered

 Item Cost

 Extended Cost

 Voucher

For Sales Invoice, the following column headers are included:

 Invoice#

 Site

 Invoice Date

 Customer

 CO#

 Cust PO

 Item

 Co Line

 Co Rel

 Qty Invoiced

 Price

 Extended Price

Drilldown Transaction Selection Criteria (Examples)

The criteria for selecting journal transactions from the ledger is determined based on the GL functions 
and its arguments.The following graphic is of the Chart of Accounts and Budget Plan form. 
Information from this graphic is used in the examples that follow.
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Consider this graphic with regard to the SLGL drilldown process:

The selection criteria is as follows:

Consider this graphic with regard to the SLGLBAL drilldown process:

The selection criteria is as follows:

Consider the following with regard to the SLGLTRAN drilldown process:

Cell Description

C6 Ledger transactions from the Start Date to the End Date of the given period 
as defined in the Accounting Periods ( 01/01/2011 and 01/31/2011)

E6 Ledger transactions between 03/01/2011 and 03/31/2011

E7 Chart of Accounts Budget and Plan form filtered by fiscal-year 2011

Cell Description

C6 Ledger transactions from the beginning of the fiscal-year (01/01/2011) until 
03/31/2011. System does not bring transactions prior to the specified fiscal-
year, although the balance amount may consist of transactions from the 
previous year

C7 Chart of Accounts Budget and Plan form filtered by fiscal-year 2011
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Ledger transactions between the start date and end date are included in the drilldown details.

Functions

The following are the User Defined Functions added to Excel when you installed the tool. These are 
NOT Infor CloudSuite functions or components; they are Excel functions. In the example formulas 
used, you can substitute a cell reference for another item when appropriate. For example, one of the 
examples below is SLGL(10200, "AUG", 2009, "600"). If "AUG" or "August" is in cell C9, your 
formula could be SLGL(10200, C9, 2009, "600") instead.

SLDESC

SLDESC returns the description associated with an account code or unit code.

Use it in this way (proper syntax): SLDESC(Account/unit code, [Unit Segment], [site], []).

 Account is the Chart of Account code or unit code.

0 returns the description for an Account Code. 0 is the default and can be omitted.

1 returns the description of Unit Code 1

2 returns the description of Unit Code 2

3 returns the description of Unit Code 3

4 returns the description of Unit Code 4

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

Examples:

SLDESC(102000) returns the description associated with the account.

SLDESC(600,1) returns the description associated with the unit code 1 (600).

SLDESC("101000") returns the description associated with the Chart of Account 101000 
from Site OH when OH is the default site.

SLDESC("101000",,"MI") returns the description associated with the Chart of Account 
101000 from Site MI.

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter, however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it is assumed to be the primary 
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GL. The value is not case sensitive. The FSB argument is ignored when the Unit Segment value 
is between 1-4. There is no separate unit code definition for FSBs in Infor CloudSuite.

Examples:

SLDESC("100000", 0, "OH") retrieves the description associated with the Chart of Account 
"100000" from Site "OH". The value for FSB name is not supplied, so the system retrieves the 
name from the default COA.

SLDESC("101000", 0, "OH", "FSB1") retrieves the description associated with the Chart of 
Account "101000" from Site "OH" and FSB "FSB1."

SLGL

SLGL returns the period balance amount for the given account code, period, and fiscal year.

Use it in this way (proper syntax): SLGL(Account [: Account], [Period], [Fiscal Year], [Unit Code 
1[,...4]], [Type], [Site], [FSB], [Currency]).

All parameters except the Account are optional. The system uses the default value when other 
parameters are not supplied. To use the default value, the parameter value has to be returned as a 
blank value supported by Excel using a pair of empty double quotes ("").

 Account is a valid account code defined in the Chart of Accounts. A range of accounts can be 
grouped by specifying a starting account and ending account separated by a colon (:).

Example:

"100100:100500"

Cell references can be used when a range is specified with the proper syntax.

Example:

SLGL(A1&":"&B2, [Period], [Fiscal Year], [Unit Code 1[,...4]], [Type], [site]).

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite.

The parameter value can be 1 to 13.

January (or Jan) to December (or Dec) also can be used to specify the accounting period. If used, 
Jan or January reads as period 1, and Dec or December reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format.

Example:

1999 or 2009.

 Unit Code is a valid unit code/sub-account defined in the Unit code table. A maximum of four unit 
codes (Unit Code 1, Unit Code 2, Unit Code 3 and Unit Code 4) can be used as a single 
parameter separated by commas. If you don’t want to use a certain unit code in the formula, then 
use a comma.

Example:

Use "600" for Unit Code 1

Use "600,,,ABC" for Unit Code 1 and Unit Code 4
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Use ",XYX,30,ABC" for Unit Code 2, Unit Code 3, and Unit Code 4

You can also use wild cards in formulas for unit codes.

Example:

Use "100, *, *, *" to return the total of Unit Code 1 (100) and everything for Unit Codes 2, 3, 
and 4.

Use "100, 001, *, *" to return the total of Unit Code 1 (100), Unit Code 2 (001) and everything 
for Unit Codes 3 and 4.

Use "*,*,*,A*" to return the total of all Unit Codes 1, 2, 3, and then any Unit Code 4 that begins 
with "A".

You can specify a range of codes in your formula.

Example:

Use "100:200, *, *,*" to return the total of the range of Unit Code 1 from 100 to 200 and 
everything for Unit Codes 2, 3, and 4.

 Type is an optional parameter. Possible values are Actual, Budget, and Plan.

Actual or A returns the actual account balance for the given period

Budget or B returns the budget amount for the given period

Plan or P returns the planning amount for the given period

The default is 'Actual'.

Example:

SLGL(10200, "AUG", 2009, "600"). The Type parameter is returned as blank, and the 
system takes the default value as Actual.

Use of empty quotations ("") can be omitted, if there is no subsequent parameter returned with a 
value.

Example:

SLGL(10200, "AUG", 2009). The last three parameters Unit Code, Type, and Site are 
omitted as there is no parameter supplied after them.

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

Examples:

SLGL(“102000”) returns the current period total.

SLGL(“102000”, 9, 2009) returns the period total for period 9 and year 2009.

SLGL(“102000”, 9, 2009, "1020") returns the balance of account code 102000 and unit code 
1 (1020) for period 9 and year 2009.

SLGL(“102000”, 9, 2009, "1020,,ABC") returns the balance of account code 102000, unit 
code 1 (1020) and unit code 3 (ABC) for period 9 and year 2009.

SLGL(“102000”, 13, 2009, "", "B") returns the budget amount for the period of 13 and fiscal 
year 2009.

SLGL(“102200:102500”, 8, 2009,, "Actual") returns total balances of accounts between 
102200 and 102500 for the period of 8 and fiscal year 2009.
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SLGL("101000") returns the amount associated with the Chart of Account 101000 from Site 
OH when OH is the default site.

SLGL("101000", 12,2008,,,"G=ALL") returns the total amount from multiple site(s) which is 
defined under Site Group Id 'ALL' for the account code 101000 for period 12, fiscal year 2008.

Examples:

102200 - Cash Account

102300 - Petty Cash

102400 - Cash at Branch x

102500 - Petty Cash Branch Y

The total of all above can be grouped into one 'cash balance' total using the range option.

Example:

= SLGL("102200:102500",3,2003)

The reporting group features can be used for more complex range or groups. See “Reporting 
Group” on page 35 for more details.

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter, however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. The value is not case sensitive.

Example:

SLGL("101000", 12,2014,,, "OH", "FSB1") retrieves the period balance from the FSB 
"FSB1"

 Currency is an optional parameter, however, use of currency must provide a valid currency code 
as arguments. The account balance is converted to the given currency by using the conversion 
method assigned to the account code. 

This parameter has no default value when the argument is empty or invalid. In this case, no 
conversion rate is applied.

Currency code is not case sensitive. 

Balance amount from FSB is not translated.

In the case that an account code range is used in the formula, the translation method is 
determined using the starting code of the range. The translated amount could be wrong if the 
account range contains one or more accounts with a different translation method other than the 
translation method of the starting code. In this scenario, we reommend you use the SLGRPGL 
function.
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SLGLBAL

SLGLBAL returns the balance amount as on a period and fiscal year for the given account and unit 
code. 

Use it in this way (proper syntax): SLGLBAL(Account [: Account], [Period], [Fiscal Year], [Unit 
Code 1[,...4]], [Type], [site], [FSB], [Currency]).

 Account is a valid account code defined in the Chart of Accounts. A range of accounts can be 
grouped by specifying a starting account and an ending account separated by a colon (:).

Example:

"100100:100500"

Cell references can be used when a range is specified with the proper syntax.

Example:

SLGLBAL(A1&":"&B2, [Period], [Fiscal Year], [Unit Code 1[,...4]])

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite

The parameter value can be 1 to 13.

January or Jan to December or Dec also can be used to specify the accounting period. If used, 
January or Jan reads as period 1, and December or Dec reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format; example - 1999 or 2009.

 Unit Code is a valid unit code/sub-account defined in the Unit code table. A maximum of four unit 
codes (Unit Code 1, Unit Code 2, Unit Code 3 and Unit Code 4) can be used as a single 
parameter separated by commas. If you don’t want to use a certain unit code in the formula, then 
use a comma.

Example:

Use "600" for Unit Code 1

Use "600,,,ABC" for Unit Code 1 and Unit Code 4

Use ",XYX,30,ABC" for Unit Code 2, Unit Code 3, and Unit Code 4

You can also use wild cards in formulas for unit codes.

Example:

Use "100, *, *, *" to return the total of Unit Code 1 (100) and everything for Unit Codes 2, 3, 
and 4.

Use "100, 001, *, *" to return the total of Unit Code 1 (100), Unit Code 2 (001) and everything 
for Unit Codes 3 and 4.

Use "*,*,*,A*" to return the total of all Unit Codes 1, 2, 3, and then any Unit Code 4 that begins 
with "A".

You can specify a range of codes in your formula.

Example:

Use "100:200, *, *,*" to return the total of the range of Unit Code 1 from 100 to 200 and 
everything for Unit Codes 2, 3, and 4.
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SLGLBAL("101000:102000", 12,2008, "100,*,*,*", "A","MI") returns the amount for the 
account code 101000 through 102000, for the 12th period of 2008, unit code 1 that is equal to 
100, everything for unit codes 2-4, and a balance type of actual from the MI site.

 Type is an optional parameter. Possible values are Actual, Budget, and Plan.

Actual or A returns the actual account balance for all periods up to the given period and fiscal 
year

Budget or B returns the budget amount for all periods up to the given period and fiscal year

Plan or P returns the planning amount for all periods up to the given period and fiscal year

The default is 'Actual'.

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

Examples:

SLGLBAL(“102000”) returns the current balance as of current period.

SLGLBAL(“102000”, 9, 2009) returns the current balance as of period 9, 2009.

SLGLBAL("101000") returns the amount associated with the Chart of Account 101000 from 
Site OH when OH is the default site.

SLGLBAL("101000", 12,2008,,,"MI") returns the amount for the account code 101000 for 
period 12, fiscal year 2008, and site MI.

SLGLBAL("101000", 12,2008,,,"GROUP=ALL") returns the sum amount for the account 
code 101000 for period 12, fiscal year 2008, and from all site(s) defined under Site Group ID 
ALL.

SLGLBAL("101000", 12,2008,,,"G=ALL") returns the sum amount for the account code 
101000 for period 12, fiscal year 2008, and from all site(s) defined under Site Group ID ALL.

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter; however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it's assumed to be the primary 
GL. The value is not case sensitive.

Example:

SLGLBAL("101000, 12,2014,,, "OH", "FSB1") retrieves the accumulated balance from the 
FSB "FSB1"

 Currency is an optional parameter, however, use of currency must provide a valid currency code 
as arguments. The account balance is converted to the given currency by using the conversion 
method assigned to the account code. 

This parameter has no default value when the argument is empty or invalid. In this case, no 
conversion rate is applied.

Currency code is not case sensitive. 

Balance amount from FSB is not translated.

In the case that an account code range is used in the formula, the translation method is 
determined using the starting code of the range. The translated amount could be wrong if the 
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account range contains one or more accounts with a different translation method other than the 
translation method of the starting code. In this scenario, we reommend you use the SLGRPGL 
function.

SLNGL

SLNGL returns the balance amount for the given account code and fiscal period with sign reversed. 
The syntax is the same as SLGL.

Example:

-1000 is returned as 1000 and vice versa

SLGLTRAN

SLGLTRAN returns the account balance for any given period other than a fiscal period.

Note: Use of SLGLTRAN should be used sparingly as it is an overloaded function. Use SLGLTRAN 
only when you need the balance amount other than for a fiscal period. If you want a fiscal-period 
balance, use SLGL or SLNGL instead. 

SLGLTRAN is useful for preparing statements with a relatively short term date range like a weekly 
cash flow or income statement for a week etc.

Use it in this way (proper syntax): SLGLTRAN (Account, [Start Date], [End Date], [Unit Code 
1[,...4]], [DebitOrCredit], [site], [FSB]).

 Account is a valid account code defined in the Chart of Accounts.

 Start Date is the beginning date of transaction and should be used in the format yyyy-mm-dd; 
example: 2009-09-17. Date should be used as a string in two quotations. 

Example:

SLGLTRAN(“10200”," 2009-09-01" ," 2009-09-15")

 End Date is the end date of transaction and should pass in the format yyyy-mm-dd; example: 
2009-09-17. Date should be used as a string in two quotations. 

Example:

SLGLTRAN(“10200”," 2009-09-01" ," 2009-09-15")

 Unit Code is a valid unit code/sub-account defined in the Unit code table. A maximum of four unit 
codes (Unit Code 1, Unit Code 2, Unit Code 3 and Unit Code 4) can be used as a single 
parameter separated by commas. If you don’t want to use a certain unit code in the formula, then 
use a comma.

Example:

Use "600" for Unit Code 1

Use "600,,,ABC" for Unit Code 1 and Unit Code 4

Use ",XYX,30,ABC" for Unit Code 2, Unit Code 3, and Unit Code 4

You can also use wild cards in formulas for unit codes.

Example:
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Use "100, *, *, *" to return the total of Unit Code 1 (100) and everything for Unit Codes 2, 3, 
and 4.

Use "100, 001, *, *" to return the total of Unit Code 1 (100), Unit Code 2 (001) and everything 
for Unit Codes 3 and 4.

Use "*,*,*,A*" to return the total of all Unit Codes 1, 2, 3, and then any Unit Code 4 that begins 
with "A".

You can specify a range of codes in your formula.

Example:

Use "100:200, *, *,*" to return the total of the range of Unit Code 1 from 100 to 200 and 
everything for Unit Codes 2, 3, and 4.

 DebitOrCredit is the type of the balance. The possible values are Debit or Dr, Credit or Cr, or 
blank.

Debit or Dr sums only debit balance.

Credit or Cr sums only credit balance.

Blank (the default) returns the net balance amount.

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

Examples:

SLGLTRAN(“102000”, "2009-08-15", "2009-09-15") returns the balance between the given 
account and date range.

SLGLTRAN(“102000”, "2009-08-15", "2009-09-15",, "Debit") returns the debit total for the 
given account and date range.

SLGLTRAN("101000", "12-01-2009", "12-05-2009") returns the amount for the account code 
101000 for the period between 12-01-2009 and 12-05-2009.

SLGLTRAN("101000", ", "12-01-2009", "12-05-2009",,,"MI") returns the amount for the 
account code 101000 for the period between 12-01-2009 and 12-05-2009 and site MI.

Note: Account codes can be used without double quotes as long as the code is only numeric. 
This doesn’t work if the account code is alpha numeric. For example, SLGLTRAN(10-2000) 
returns an error. It should be specified as SLGLTRAN(“10-2000”).

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter; however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it's assumed to be the primary 
GL. The value is not case sensitive.

SLNGLBAL

SLNGLBAL returns the balance amount for the given account code and fiscal period with sign 
reversed. The syntax is the same as SLGLBAL.

Example:

-1000 is returned as 1000 and vice versa
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SLNGLTRAN

SLNGLTRAN returns the balance amount for the given account code and fiscal period with sign 
reversed. The syntax is the same as SLGLTRAN.

Example:

-1000 is returned as 1000 and vice versa

SLPARMS

SLPARMS returns company-specific information such as company name, site, etc.

Use it in this way (proper syntax): SLPARMS("Company") or SLPARMS("Site") or 
SLPARMS("Period") or SLPARMS("Fiscal_year"). You can add an optional parameter of site at the 
end.

 Company - Returns the company name.

 Site - This site returns the default site.

 Period - Returns the current period.

 Fiscal_year - Returns the current fiscal year.

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

Examples:

SLPARMS(“COMPANY”, “OH”) returns the company name of site OH

SLPARMS(“FISCAL_YEAR”, “OH”) returns the current fiscal year site OH

SLPARMS(“PERIOD”) returns the current period of the current site

SLPL

SLPL returns the difference amount of revenue and expenditure for a period and fiscal year.

Note: SLPL is used in the Balance Sheet Report templates to calculate the estimated Profit or Loss.

Use it in this way (proper syntax): SLPL([period], [fiscal_year], [site]).

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite

The parameter value can be 1 to 13.

January or Jan to December or Dec also can be used to specify the accounting period. If used, 
January or Jan reads as period 1, and December or Dec reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format; example - 1999 or 2009.
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 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes.

 IncludeClosingBal is an optional parameter that can take values of Y or N. The default value of 
N means the summary amount from year-end closing entries are not be considered while 
calculating the balance of an account. The value Y indicates that the closing entries are included. 
For example, when IncludeClosingBal = Y, if the Sales Revenue account has a balance of $1000 
at year-end, when the year-end closing entries are passed, the balance of this account becomes 
$0. When IncludeClosingBal = N, the value returned by the function is $1000.

SLPLMTD

SLPLMTD returns the difference amount of revenue and expenditure for a single period.

Note: SLPLMTD is used in the Balance Sheet Report templates to calculate the estimated Profit or 
Loss.

Use it in this way (proper syntax): SLPLMTD([period], [fiscal_year], [site]).

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite

The parameter value can be 1 to 13.

January or Jan to December or Dec also can be used to specify the accounting period. If used, 
January or Jan reads as period 1, and December or Dec reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format; example - 1999 or 2009.

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes.

 IncludeClosingBal is an optional parameter that can take values of Y or N. The default value of 
N means the summary amount from year-end closing entries are not be considered while 
calculating the balance of an account. The value Y indicates that the closing entries are included. 
For example, when IncludeClosingBal = Y, if the Sales Revenue account has a balance of $1000 
at year-end, when the year-end closing entries are passed, the balance of this account becomes 
$0. When IncludeClosingBal = N, the value returned by the function is $1000.

SLGRPDESC

SLGRPDESC returns the Description associated with a Reporting Group Code.

Use it in this way (proper syntax): SLGRPDESC (Group Name).

 Group Name is a valid group code defined in the Reporting Group.

Example:

=SLGRPDESC("COG")
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SLGRPGL

SLGRPGL retrieves period balance for a given Account Code, Period and Fiscal-year.

Use it in this way (proper syntax): SLGRPGL (Group Name, [period], [fiscal year], [Type], [Site], 
[FSB], [Currency]).

 Group Name is a valid group code defined in the Reporting Group.

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite.

The parameter value can be 1 to 13.

January (or Jan) to December (or Dec) also can be used to specify the accounting period. If used, 
Jan or January reads as period 1, and Dec or December reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format; example - 1999 or 2009.

 Type is an optional parameter. Possible values are Actual, Budget, and Plan.

Actual or A returns the actual account balance for all periods up to the given period and fiscal 
year

Budget or B returns the budget amount for all periods up to the given period and fiscal year

Plan or P returns the planning amount for all periods up to the given period and fiscal year

The account COA code and unit code values are picked up from the Group definition.  The COA 
codes and unit codes defined under a group definition is not site specific. These codes are used to 
retrieve the data from the site specified in the SLGRPGLBAL and SLGRPGL functions. If the code 
doesn't exist in any site, it simply returns nothing; no error message is displayed.

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter, however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it is assumed to be the primary 
GL. The value is not case sensitive.

 Currency is an optional parameter, however, use of currency must provide a valid currency code 
as arguments. The account balance is converted to the given currency by using the conversion 
method assigned to the account code. 

This parameter has no default value when the argument is empty or invalid. In this case, no 
conversion rate is applied.

Currency code is not case sensitive. 

Balance amount from FSB is not translated.

In the case that an account code range is used in the formula, the translation method is 
determined using the starting code of the range. The translated amount could be wrong if the 
account range contains one or more accounts with a different translation method other than the 
translation method of the starting code. In this scenario, we reommend you use the SLGRPGL 
function.
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SLGRPGLBAL

SLGRPGLBAL retrieves balance for a given Account Code, Period and Fiscal-year.

Use it in this way (proper syntax): SLGRPGLBAL (Group Name, [period], [fiscal year], [Type], [Site], 
[FSB], [Currency]).

 Group Name is a valid group code defined in the Reporting Group.

 Period is an optional parameter. If not supplied, the value from the Period column of the toolbar is 
used. If the Period column in the toolbar is empty, it picks the current period from Infor CloudSuite.

The parameter value can be 1 to 13.

January (or Jan) to December (or Dec) also can be used to specify the accounting period. If used, 
Jan or January reads as period 1, and Dec or December reads as period 12.  This is useful for 
users who uses 12 month periods starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, the value from the Year column of the 
toolbar is used. If the Year column in the toolbar is empty, it picks the current fiscal year from Infor 
CloudSuite. Year should be specified in century format; example - 1999 or 2009.

The account COA code and unit code values are picked up from the Group definition.  The COA 
codes and unit codes defined under a group definition is not site specific. These codes are used to 
retrieve the data from the site specified in the SLGRPGLBAL and SLGRPGL functions. If the code 
doesn't exist in any site, it simply returns nothing; no error message is displayed.

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter, however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it is assumed to be the primary 
GL. The value is not case sensitive.

 Currency is an optional parameter, however, use of currency must provide a valid currency code 
as arguments. The account balance is converted to the given currency by using the conversion 
method assigned to the account code. 

This parameter has no default value when the argument is empty or invalid. In this case, no 
conversion rate is applied.

Currency code is not case sensitive. 

Balance amount from FSB is not translated.

In the case that an account code range is used in the formula, the translation method is 
determined using the starting code of the range. The translated amount could be wrong if the 
account range contains one or more accounts with a different translation method other than the 
translation method of the starting code. In this scenario, we reommend you use the SLGRPGL 
function.

SLGRPGLYTDBAL

This function is the same as SLGRPGLBAL except the balances are only from the current fiscal-year 
and do not include any previous year balance.
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SLNGRPGLYTDBAL

This function is same as SLGRPGLYTDBAL except the result is reversed to the opposite sign. For 
example: minus to plus or plus to minus.

SLNGRPGL

SLNGRPGL is the same as SLNGRPGL. The value is returned with reverse sign.

Use it in this way (proper syntax): SLNGRPGL(Group Name, [period], [fiscal year], [Type], [Site]).

SLNGRPGLBAL

SLNGRPGLBAL is the same as SLGRPGLBAL. The value is returned with reverse sign.

Use it in this way (proper syntax): SLNGRPGLBAL(Group Name, [period], [fiscal year], [Type], [Site]).

SLGLYTDBAL

SLGLYTDBAL returns the balance amount computed from the beginning of the given fiscal year until 
the given period of the same fiscal year for the given account and unit code. 

Use it in this way (proper syntax): SLGLYTDBAL (Account [: Account], [period], [Fiscal year], [U1 [:U1] 
[,...4]], Type, Site, [FSB], [Currency]).

 Account is a valid account code defined in the Chart of Accounts. A range of accounts can be 
grouped by specifying a starting account and ending account separated by a “:” (colon). Cell 
references can be used when a range is specified with the proper syntax.

Example:

SLGLYTDBAL(A1&":"&B2, ...)

 Period is an optional parameter. If not supplied, it will default the value from the Period column of 
Tool Bar. If Period column in the Tool Bar is empty then it picks the current period from Infor 
CloudSuite. The parameter value can be, 1 to 13. 

January (or Jan) to December (or Dec) also can be used to specify the accounting period. If used, 
Jan or January will read as period 1 and Dec or December will read as period 12.  This is useful 
for users who uses 12 months period starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, it will default the value from the Year column 
of Tool Bar. If the Year column in the Tool Bar is empty, it picks the current Fiscal Year from Infor 
CloudSuite. Year should be specified in century format. example - 1999 or 2009

 Unit Code is a valid unit code/sub-account defined in the Unit code table. A maximum of four unit 
codes (Unit Code 1, Unit Code 2, Unit Code 3 and Unit Code 4) can be used as a single 
parameter separated by commas. If you don’t want to use a certain unit code in the formula, then 
use a comma.

Example:

Use "600" for Unit Code 1

Use "600,,,ABC" for Unit Code 1 and Unit Code 4
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Use ",XYX,30,ABC" for Unit Code 2, Unit Code 3, and Unit Code 4

You can also use wild cards in formulas for unit codes.

Example:

Use "100, *, *, *" to return the total of Unit Code 1 (100) and everything for Unit Codes 2, 3, 
and 4.

Use "100, 001, *, *" to return the total of Unit Code 1 (100), Unit Code 2 (001) and everything 
for Unit Codes 3 and 4.

Use "*,*,*,A*" to return the total of all Unit Codes 1, 2, 3, and then any Unit Code 4 that begins 
with "A".

You can specify a range of codes in your formula.

Example:

Use "100:200, *, *,*" to return the total of the range of Unit Code 1 from 100 to 200 and 
everything for Unit Codes 2, 3, and 4.

 Type is an optional parameter. Possible values are Actual, Budget, and Plan.

Actual or A returns the actual account balance for all periods up to the given period and fiscal 
year

Budget or B returns the budget amount for all periods up to the given period and fiscal year

Plan or P returns the planning amount for all periods up to the given period and fiscal year

 Site is a valid site name. Site is an optional parameter. If you do not provide this parameter, the 
default site is used. This parameter can take two types of values, Site and Site Group. The site 
value is specified by entering the site id in double quotes. The Site Group ID is specified with a 
prefix "G=Site Group" or "GROUP=Site Group".

 FSB is a valid Multi-Financial Set of Books name. You can omit the argument for this optional 
parameter, however, the use of FSB must provide a valid FSB name as the argument. It has no 
default value, when the argument is empty or invalid. In this case, it is assumed to be the primary 
GL. The value is not case sensitive.

Example:

SLGLYTDBAL("101000", 12,2014,,, "OH", "FSB1") retrieves the accumulated balance from 
the beginning of given fiscal-year from the FSB "FSB1"

 Currency is an optional parameter, however, use of currency must provide a valid currency code 
as arguments. The account balance is converted to the given currency by using the conversion 
method assigned to the account code. 

This parameter has no default value when the argument is empty or invalid. In this case, no 
conversion rate is applied.

Currency code is not case sensitive. 

Balance amount from FSB is not translated.

In the case that an account code range is used in the formula, the translation method is 
determined using the starting code of the range. The translated amount could be wrong if the 
account range contains one or more accounts with a different translation method other than the 
translation method of the starting code. In this scenario, we reommend you use the SLGRPGL 
function.
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SLCURRENCYRATE

SLCURRENCYRATE returns the currency rate of currency for a period and fiscal-year.

Use it in this way (proper syntax): SLCURRENCYRATE (Currency, [period], [fiscal year], [Translation 
Method], [Site]).

 Currency is a valid currency code. A valid currency code is the one which is defined in the 
currency table.

Currency has no default value when the argument is empty or invalid. In this case, no conversion 
rate is applied.

Currency code is not case sensitive. 

 Period is an optional parameter. If not supplied, it defaults the value of the Period dropdown from 
the Tool Bar. If the Period column in the Tool Bar is empty, it picks the current period from Infor 
CloudSuite Industrial. 

The parameter value can be, 1 to 13. 

January (| Jan) to December (| Dec) also can be used to specify the accounting period. If used, 
Jan | January will read as period 1 and Dec | December will read as period 12.  This is useful for 
users who uses 12 months period starting from January to December.

 Fiscal Year is an optional parameter. If not supplied, it will default the value from the Year column 
of Tool Bar. If Year column in the Tool Bar is empty, it picks the current Fiscal Year from SyteLine. 
Year should be specified in century format. Eg 1999 or 2009

 Translation Method. Possible values are A (Average), E (End of Period), and C (Current). The 
default is Current when no value is explicitly supplied.

Associating a Site with a Worksheet
You can associate a site with a worksheet. If you have multiple sites, you might create one Excel 
workbook with multiple worksheets; each worksheet associated with a different site. The site chosen 
then becomes the default site for that worksheet. When a site is associated with a worksheet, you 
don’t have to use the site parameter in the formulas you write. In most cases, we recommend that you 
include the site name in all formulas, to provide clarity about from which site the data comes. The 
exception to this is for dynamic worksheets that you run against different sites.

To associate different worksheets with different sites:

1 Select a site name from the drop-down list in the toolbar.

2 Right-click on the worksheet tab and select Associate Site(sitename).

The worksheet stays associated with that site even when you select a different default site name 
in the toolbar. If you do not associate a site with a worksheet, the ‘home site’ is the default. The 
’home site’ is defined as part of the setup when you specify a connection to a Infor CloudSuite 
database server and application (site) database.
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A workbook can display data from more than one Infor CloudSuite site, as long as the following 
criteria are met:

 The site must be on the same database server as the home site.

 The site must be listed on the Sites/Entities form at the home site, and the Application Database 
field on that form must be filled in for the site.  

Any sites that meet this criteria display in the drop-down list on the toolbar.

Building a Dynamic Excel Report
You can insert Infor CloudSuite parameters (Site, Period, and Year) into specific cells. These cells 
then have a drop-down which shows the available sites, periods, and fiscal years.

1 Right-click in a cell.

2 Select Insert Infor CloudSuite Parameters and then either Site, Period, or Fiscal Year. You 
can also select unit codes 1-4. The cell now has a drop-down containing all possible options for 
site or period or fiscal year.
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2Chapter 2: Microsoft Outlook Add-in for 
Infor CloudSuite

This section describes how to use the Infor CloudSuite Outlook add-in. It also includes the steps to 
install and set up the add-in.

Overview
For many people, especially those in Sales or Marketing positions, Microsoft Outlook is an essential 
tool for communication and organization. You use Outlook tools to manage your e-mail, your 
calendar, your list of tasks, and your contacts. 

Calendars, Tasks, and Contacts

Infor CloudSuite includes a User Calendar, Task Lists and Contacts that can be tightly integrated with 
their Outlook counterparts, so you can work with the same information seamlessly in both Outlook 
and Infor CloudSuite. With the click of a button, you can selectively duplicate contacts, appointments, 
and tasks from either Outlook or Infor CloudSuite into the other application. Your Outlook Contacts tab 
also shows a subset of the Sales Contacts form from Infor CloudSuite so you can easily view 
information about the current contact that is stored in Infor CloudSuite.

E-mails

When you view e-mails in Outlook to or from certain customers, vendors, prospects, and sales 
contacts, the Infor CloudSuite details display along with the e-mail, for easy reference when you reply 
to or call that customer, vendor, prospect, or sales contact. The details of Infor CloudSuite interactions 
are also available with the Outlook e-mail, so you can see all interactions and refer to ongoing 
discussions.

You can also add selected incoming or outgoing Outlook e-mails to the Infor CloudSuite Customer 
Interactions, Vendor Interactions, Prospect Interactions and Sales Contact Interactions forms by 
clicking a button in Outlook.
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SmartLink

You can enable SmartLink in the Outlook add-in. SmartLink scans your incoming Outlook e-mails for 
certain search items - key words that are defined in the Search Items form in Infor CloudSuite - based 
on whether the e-mail is coming from a customer, vendor, prospect, employee, or contact defined in 
Infor CloudSuite, or from another Infor CloudSuite user. 

From the Outlook add-in options dialog box, you can click a link to open the Search Preference List 
form in Infor CloudSuite. Use that form to define which search items the add-in should look for in e-
mails coming from certain groups of senders. For example, you can specify that the add-in should 
look in the Infor CloudSuite database for PONum data that matches any text in e-mails sent from 
people who match a contact e-mail address included in the Vendors search group.

If you set up the example above, SmartLink searches for data matching PO numbers in Outlook e-
mails from contacts who are defined in Infor CloudSuite as vendors. If you receive an e-mail from a 
vendor that contains the text 1089679, and if SmartLink finds a matching PO number 1089679 in the 
Infor CloudSuite database, then when you open the e-mail, SmartLink causes the text 1089679 in the 
e-mail to display as a hyperlink. When you click the link, the Purchase Orders form is displayed in a 
separate browser window, filtered to show additional details about PO 1089679. 

Infor CloudSuite Explorer in Outlook

Use the Infor CloudSuite Explorer module in Outlook to open Infor CloudSuite forms directly in the 
Outlook reading pane. (Or you can set up the add-in so that forms open in a separate browser 
window.) You can customize this Explorer to include only the forms that you access regularly, and you 
can set up filters so that the forms show only the information that interests you. 

Behind the Scenes

This is what happens in the system when you synchronize the data from either Outlook or Infor 
CloudSuite, or when you open an e-mail relating to a customer you designated in Outlook as a Infor 
CloudSuite customer:

The add-in communicates through the IDO Web Service on the Infor CloudSuite utility server, 
enabling Outlook to make calls over the Internet to load (that is, read from) or update (write to) Infor 
CloudSuite IDO collections. The data result set is returned to Outlook through an XML interface over 
HTTP using SOAP protocol.
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Requirements
Before you can install and use the Outlook add-in, ensure that these requirements are met:

 You are using Microsoft Office Outlook 2010 or 2013.

 You are using Infor CloudSuite 9.00.00 or higher.

 The IDO Request Web Service option was installed with the Infor CloudSuite utility/web server.

 You must be logged in as an administrator on the computer where you are installing the Outlook 
add-in.

Installing and Setting Up Outlook Integration with 
Infor CloudSuite

Upgrading

If you are upgrading from a previous release of the Outlook add-in, use the Add or Remove Programs 
utility to remove the Infor CloudSuite Outlook add-in before installing the new version.

Installing the Infor CloudSuite Outlook Add-in

To install the add-in on your computer:

1 Copy InforCloudSuiteOutlookAddin.exe from the 
InforCloudSuiteOfficeIntegrations[version].zip file to a local folder on your client computer, for 
example C:\Temp.

2 On your computer, double-click InforCloudSuiteOutlookAddin.exe to run the installation. 
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3 When asked whether to remove the installation files, read the instructions and select an option:

 The first option allows the setup to choose the folder where it will unpack the installation files. 
This can cause an error if you do not have appropriate permissions on the selected folder.

 The second option is recommended, because you can specify a folder that has appropriate 
permissions.

4 Some files are loaded and the installer screen is displayed.

5 Click Install.

Before the customization installation starts, it checks your system for all the required components. 
If it finds missing components, it tries to download them from the Microsoft site, if an internet 
connection is present. Otherwise it returns an error, asking you to perform a .Net update. 

6 When the customization installation is complete, open Microsoft Outlook. 

Note: If this is an upgrade or a reinstallation, a message is displayed asking you to close and 
reopen Outlook. Do this to refresh the contents of the configuration file.

7 In Outlook you should see this new menu option (This example is from Outlook 2013.):

Note: If you want to temporarily disable the add-in in Outlook without uninstalling it, select File > 
Options > Add-Ins. Select Manage COM Add-ins and click Go. Clear the Infor CloudSuite Outlook 
Add-in check box.

To enable it again, follow the same steps and select the Infor CloudSuite Outlook Add-ins check 
box.
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Setting Up the Add-in in Outlook

To set up the add-in in Microsoft Outlook after it is installed:

1 Select File > Options > Add-Ins and click Add-Ins Options.

2 Specify these values on the Infor CloudSuite Setup tab:

 Use Workstation Login: Select this check box use use the workstation login. If selected, the 
Infor CloudSuite User ID and Password fields are disabled.

 Infor CloudSuite User ID: Enter a user name that is valid for the specified Infor CloudSuite 
configuration. If not supplied, the system uses the default Windows login name.

 Password: Enter the password for the specified user.

 Infor CloudSuite Config: Click Load Config to load the list of configurations based on the 
URL in the End Point field. Then specify the name of the configuration you want to access 
through the Infor CloudSuite utility server. 

 Auto Sync Out (Contact, Task, Appointment): Select any or all of these check boxes if you 
want to automatically synchronize to Infor CloudSuite any changes made in Outlook, without 
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clicking the Sync Out All button on the Outlook toolbar.  For example, if these fields are 
selected and you add a new contact, task, or appointment in Outlook, it is automatically added 
to the Infor CloudSuite Sales Contacts, Infor CloudSuite Task List, or Infor CloudSuite User 
Calendar.

 End Point: Enter the URL address of the IDO web service on the Infor CloudSuite web/utility 
server where the configuration you want to access is defined. For example:  http://
servername/IDORequestService/IDOWebService.aspx 

 Web Client URL: Enter the URL address of the Infor CloudSuite web server where the web 
rendering client is installed. For example:  http://servername/wswebclient/default.aspx

 Display form inside the default browser: Select this option to place the Infor CloudSuite 
Explorer pane in a separate instance of your default Web browser. By default, the Explorer is 
displayed inside an Outlook window. For more information, see “Using the Infor CloudSuite 
Explorer in Outlook” on page 104.

 Enable SmartLink: Select this option to enable the SmartLink feature in Outlook. For more 
information, see “Using SmartLink with Outlook E-mails” on page 93.

 Set Search Preference: If you enabled SmartLink, click this link to open the Infor CloudSuite 
Search Preferences form, where you can specify the types of text you want SmartLink to 
search for in the Infor CloudSuite database. For more information, see the Infor CloudSuite 
help on setting up SmartLink search preferences. If you are a system administrator who 
wants to create additional search items, see the Infor CloudSuite help on setting up search 
items.

 Display Infor CloudSuite Sales Contacts form in Outlook Contact: Select this option if 
you want to display a subset of the Sales Contacts form, filtered to display Infor CloudSuite 
settings for the current Outlook contact, in the Outlook contact pane. For more information, 
see “Viewing Sales Contacts in Outlook” on page 81.
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3 On the Infor CloudSuite Interactions tab:

 Select or clear interaction types you wish to use. This table describes each interaction type:

Type Search Result

Customer Search for External and 
Internal email address in 
Customers. When no match is 
found, then search for Email in 
Customer Contact. 

Customer Order and Order details 

Vendor Search for External and 
Internal Email Address in 
Vendors. 

Purchase Order and details

Prospect Search for Email in Prospect 
Sales Contact Cross 
Reference.

Opportunities and Opportunity Tasks
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 When selected, the interaction type is available in the drop-down, so the email message can 
be attached to the selected interaction log. 

 Selected items are the list source for the Interaction Type drop-down in the Interaction Pane. 
The first selected item from the list is the default value for the drop-down. The search is 
performed in the order as it appears in the list. The order can be re-arranged using the Up and 
Down arrow keys.

Note: You must select Incident to enable the ability to create incidents, events, and notes from 
Outlook messages. 

4 Click OK. 

5 A prompt indicates that the data was saved to the Outlook store. Click OK.

Contact Search for Email in Sales 
Contact Sales Person Cross 
Reference. 

Sales Person(s) associated with the 
contact

Incident Search for Email in Incidents. Incidents 

Type Search Result
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6 On the Sync Options tab,
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 Select or clear the check boxes for First Name, Last Name, Company, and Email to verify if a 
contact already exists in Infor CloudSuite.

During the synchronization process, the add-in establishes a link between Outlook and an Infor 
CloudSuite contact using a unique id (RowPointer from Infor CloudSuite contact record). This 
will facilitate future bi-directional synchronization and ensures the contacts are not duplicated 
on either side; instead, it performs an update. When you perform a Sync Out process from 
Outlook, the add-in first tries to match the contact in Infor CloudSuite using the id, then it 
updates the record when a match found. It creates a new contact when no match exists in Infor 
CloudSuite.

In some cases, different users may have the same contact in their Outlook contact folder, so 
when they try to Sync Out their contact, it may end up duplicating records in Infor CloudSuite. 
This usually happens when users migrate to the new system for the first time. In this case, you 
can implement additional contact matching criteria using the Sync Options. The available 
search properties are First Name, Last Name, Company, and Email. We recommend that you 
select all the properties to ensure best matching of records.

This example explains how the additional search criteria helps to not duplicate contacts in Infor 
CloudSuite.

Example - User A and B have the same contacts with the same First Name, Last Name, 
Company, and Email address. When user A uses Sync Out for the first time, it creates a new 
contact in Infor CloudSuite and establishes a link for future updates. When user B tries to Sync 
Out, the add-in will not find a match, so it performs an additional search using the First Name, 
Last Name, Company, and Email address to find a match. So, it the establishes a link with the 
existing contact and performs an update instead of creating a new contact.

Note: The settings are saved into the users’ local machine, so it has to be set up in every user’s 
machine that will be synchronizing contacts. The additional duplicate check is performed only 
when performing Sync Out process.
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7 On the Service tab: 

 Select Flag Incident email messages with special icon. to display a special icon beside 
messages that have been converted into an incident or event. 

 Select Perform Smart Search when opens a message. to automatically search for special 
key characters, such as an incident number, in the message body or subject line when 
opening a message, then automatically set the Incident number after validating. When this 
check box is cleared, use the Search button to search for an incident number.

 Select Add Outlook Reminder automatically for the Incident. to automatically create an 
Outlook reminder from an email message by using the follow-up date. 

 If you typically use the same event code when creating a new event, select that code in the 
Event Code field. This code will be automatically set when creating new events. 

8 Click Apply. 
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Linking Windows User Names to Infor CloudSuite Salespersons

Microsoft Outlook can recognize you as a Infor CloudSuite salesperson and display Infor CloudSuite 
information specific to you, if you meet all of these requirements in setting up your user names on 
Infor CloudSuite and Microsoft Windows:

 Your Windows user name and your Infor CloudSuite user name are the same. (If they are 
different, the system uses the name defined in the Infor CloudSuite tab of the Outlook options, 
shown above.)

 Your Infor CloudSuite user name is assigned to a salesperson on the Salespersons form in Infor 
CloudSuite.

Setting Infor CloudSuite User License and Authorizations

In order to use the Infor CloudSuite add-in, you must have a valid Infor CloudSuite user name. This is 
the user name that is specified in the Infor CloudSuite tab of the Outlook Options dialog box. (See 
“Setting Up the Add-in in Outlook” on page 65.)

Licenses

To use any of the features, a SyteLIne user must be assigned a SyteLineAutomation license. Infor 
CloudSuite Industrial users must be assigned an Automation license.

To view the Sales Contacts (Office) form, which is available in the Outlook Contacts tab as well as in 
Infor CloudSuite, SyteLine users must be assigned a SyteLineOfficeIntegration license. Infor 
CloudSuite Industrial users must be assigned an OfficeIntegration license.This module allows you to 
display custom Infor CloudSuite forms inside Microsoft Office modules. 

To open other Infor CloudSuite forms through the Explorer in Outlook, a SyteLine user name must be 
assigned a standard SyteLineAutomation license. An Infor CloudSuite Industrial user must be 
assigned the Automation license. When the user opens an Infor CloudSuite form through the Outlook 
Explorer, one instance of that license is consumed.

For more information about any of these license types, see the Infor CloudSuite Industrial Licensing 
guide.

Authorizations

On the Object Authorizations for User form in Infor CloudSuite, these privileges must be granted 
for this user, for object type MIDDLEWARE:

Object Name
Edit 
Privilege

Execute 
Privilege

Read 
Privilege

Update 
Privilege

DocumentTypes Revoked Granted Granted Revoked

MonitoredResources Revoked Granted Granted

SearchPreferenceLists Revoked Granted Granted
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The highlighted sections above indicate IDOs where update privileges must be granted. All other 
IDOs require read privilege for this user. Note that the MIDDLEWARE authorizations do not affect the 
user’s ability to edit or view information through Infor CloudSuite forms.

Seeing the Sync Buttons In Infor CloudSuite

The MS Outlook Sync In, MS Outlook Sync Out, and MS Outlook Sync Out All buttons display in 
these Infor CloudSuite forms only if there is a Microsoft Outlook client installed and active on the 
same computer where the Infor CloudSuite client is installed:

 Sales Contacts

 Task List

 User Calendar

SLCoitems Revoked Granted Granted

SLContacts Granted Granted Granted Granted

SLContactSlspersons Granted Granted Granted Granted

SLCos Revoked Granted Granted

SLCustomers Revoked Granted Granted

SLCustomerContacts Granted Granted Granted Granted

SLDocumentObjectAndRefExt
Views

Granted Granted Granted Granted

SLForms Revoked Granted Granted

SLInteractions Granted Granted Granted Granted

SLInteractionDetails Granted Granted Granted Granted

SLInteractionTopics Revoked Granted Granted

SLOpportunities Revoked Granted Granted

SLProspectContacts Granted Granted Granted Granted

SLSlsmans Revoked Granted Granted

SLUserLocals Revoked Granted Granted

UserNames Revoked Granted Granted

UserTasks Granted Granted Granted Granted

UserCalendars Granted Granted Granted Granted

SLVendors Revoked Granted Granted Revoked

SLPos Revoked Granted Granted Revoked

SLPoitems Revoked Granted Granted Revoked

SLProspects Revoked Granted Granted Revoked

Object Name
Edit 
Privilege

Execute 
Privilege

Read 
Privilege

Update 
Privilege
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Using the Outlook Add-in

Sync In or Sync Out?

You can create and update your contacts, tasks, and appointments in either Infor CloudSuite or 
Microsoft Outlook and synchronize the changes so they appear in the other system. In Outlook, you 
can sync in or synch out all, or you can sync in or sync out individual pieces.

Look at the buttons on the menu. Infor CloudSuite Contact, Infor CloudSuite Task, and Infor 
CloudSuite Calendar are all sync in buttons. Outlook Contact, Outlook Task, and Outlook 
Calendar are all sync out buttons.

This table shows the result of clicking the sync in or sync out buttons.

Button Result

Infor CloudSuite 
Contact

Pulls all new and changed 
Contact(s) from Infor 
CloudSuite and updates 
Outlook Contact(s).

Infor CloudSuite 
Task

Pulls all new and changed 
Task(s) from Infor CloudSuite 
and updates Outlook Task(s).

Infor CloudSuite 
Calendar

Pulls all new and changed 
Appointment(s) from Infor 
CloudSuite and updates 
Outlook Appointment (s).

Outlook Contact Connects to Infor CloudSuite 
and updates all new and 
changed Outlook Contact(s).

Outlook Task Connects to Infor CloudSuite 
and updates all new and 
changed Outlook Task(s).

Outlook Calendar Connects to Infor CloudSuite 
and updates all new and 
changed Outlook 
Appointment(s).

Sync In All Pulls all new and changed 
Task(s), Contact(s) and 
Appointment(s) from Infor 
CloudSuite and updates 
Outlook.
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Decide which system - Infor CloudSuite or Outlook - is the "master" system where your contacts, 
tasks and appointments are created. The other system can contain synchronized copies of that 
information. Your decision determines whether you use the Sync In button or the Sync Out button. 

Your system administrator may tell you which button to use. 

Sync In and Sync Out synchronize your contacts, tasks and appointments, but not those created by 
other users.

Caution

When you use Sync In or Sync Out, the sending system overwrites the existing contact, task or 
appointment information in the receiving system. So, for example, you should not try to maintain the 
same contact with different information in Infor CloudSuite and Outlook.

In Outlook

In Microsoft Outlook, these Sync options are available:

 If you create your contacts, tasks and calendar appointments in Microsoft Outlook, use the 
appropriate sync out buttons on the Infor CloudSuite menu to copy: 

 All tasks flagged as "Task in Infor CloudSuite" from Outlook to the Infor CloudSuite Task List 
form

 All contacts flagged as "Contact in Infor CloudSuite" from Outlook to the Infor CloudSuite 
Sales Contacts form

 All calendar appointments flagged as "Appointment in Infor CloudSuite" from Outlook to the 
Infor CloudSuite User Calendar form.

To copy a specific task, contact, or appointment, display it and use the appropriate sync out 
button on the Infor CloudSuite menu.

Sync Out All Connects to Infor CloudSuite 
and updates all new and 
changed Outlook Task(s), 
Contact(s) and 
Appointment(s).

Button Result
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 If you create your contacts, tasks and calendar appointments in Infor CloudSuite, use the 
appropriate sync in buttons on the Infor CloudSuite menu to copy all contacts, tasks, and 
appointments you created in Infor CloudSuite to your Outlook contacts, tasks, and appointments 
areas.

To copy changes to a specific contact, task, or appointment that already exists in both Infor 
CloudSuite and Outlook, display it and use the appropriate sync out button on the Infor 
CloudSuite menu.

 If Auto Sync Out is selected in the Infor CloudSuite tab of the Outlook Options dialog box, then 
any time you add or update a Infor CloudSuite-designated task, contact, or appointment in 
Outlook, the information is duplicated to Infor CloudSuite.

You can also toggle the Disable/Enable Auto Sync Out button on the appropriate ribbon 
toolbars. This button overrides the Auto Sync Out setting in the Options dialog. If this button is set 
to "Enable," the add-in immediately synchronizes new or existing Infor CloudSuite-designated 
contacts, tasks or appointments from Outlook to Infor CloudSuite as soon as you save them. If it 
is set to "Disable," you must select Sync Out to manually perform the synchronizations.

In Infor CloudSuite

Use the Sync buttons in the appropriate Infor CloudSuite forms to synchronize contacts, tasks and 
appointments. These buttons are enabled when Outlook is installed and active on the computer 
where Infor CloudSuite is running.

MS Outlook Sync In Button: Use this button to synchronize Infor CloudSuite information that was 
created or updated in Microsoft Outlook, so that it is displayed in the appropriate Infor CloudSuite 
form (see the table below). 

After the synchronization, select View > Refresh to see the new or changed information in the Infor 
CloudSuite form.

On this form Use this button to Notes

 Sales Contacts Synchronize contact information 
that was created or updated in 
Microsoft Outlook and marked as 
"Contact in Infor CloudSuite", so 
that it is displayed in the Sales 
Contacts form.

Before you synchronize Infor CloudSuite 
contacts from Outlook, make sure the 
contact's last name, first name, and business 
phone numbers are saved in Outlook; if any 
of these fields are missing, an error is 
displayed and skips updating the contact in 
Infor CloudSuite.

Task List Synchronize task information that 
was created or updated in Microsoft 
Outlook and marked as "Task in 
Infor CloudSuite", so that in the 
Infor CloudSuite Task List form it is 
displayed.

You cannot change the task name in Infor 
CloudSuite after the task exists there. 

User Calendar Synchronize Infor CloudSuite 
calendar information that was 
created or updated in Microsoft 
Outlook and marked as 
"Appointment in Infor CloudSuite", 
so that in the Infor CloudSuite User 
Calendar it is displayed.

A new appointment must have a unique user 
ID, appointment name, start time, and end 
time in order to be imported into Infor 
CloudSuite. Existing appointments can be 
updated with a new start time and end time.
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MS Outlook Sync Out Button: Use this button to synchronize the information for the current record 
that was created or updated in the appropriate Infor CloudSuite form (see the table below), so that in 
Microsoft Outlook it is displayed. 

MS Outlook Sync Out All Button: Use this button to synchronize all information that was created or 
updated in the appropriate Infor CloudSuite form (see the table below), so that in Microsoft Outlook it 
is displayed. 

On this form Use this button to Notes

Sales Contacts Synchronize the information for the 
current contact that was created or 
updated in the Sales Contacts form, 
so that in Microsoft Outlook it is 
displayed..

Before you synchronize Infor CloudSuite 
contacts from Outlook, make sure the 
contact's last name, first name, and business 
phone numbers are saved in Outlook; if any 
of these fields are missing, an error is 
displayed and skips updating the contact in 
Infor CloudSuite.

The contact is marked in Outlook as "Contact 
in Infor CloudSuite."

Task List Synchronize information for the 
current task that was created or 
updated in the Sales Contacts form, 
so that in Microsoft Outlook it is 
displayed.

The task is marked in Outlook as "Task in 
Infor CloudSuite."

User Calendar Synchronize the current 
appointment from the Infor 
CloudSuite calendar, so that in 
Microsoft Outlook it is displayed.

The appointment is marked in Outlook as 
"Appointment in Infor CloudSuite."

On this form Use this button to Notes

Sales Contacts Synchronize all Infor CloudSuite 
sales contact information that was 
created or updated in the Sales 
Contacts form, so that in Microsoft 
Outlook it is displayed.

Before you synchronize Infor CloudSuite 
contacts into Outlook, make sure each 
contact's last name, first name, and office 
phone numbers are saved in Infor 
CloudSuite. The contacts are marked in 
Outlook as "Contact in Infor CloudSuite."

Task List Synchronize all Infor CloudSuite 
task information that was created or 
updated in the Task List form, so 
that in Microsoft Outlook it is 
displayed.

You cannot change the task name in Infor 
CloudSuite after the task exists there. The 
tasks are marked in Outlook as "Task in Infor 
CloudSuite."

User Calendar Synchronize all Infor CloudSuite 
appointments for the current user 
that are not past due, so that they 
display in Microsoft Outlook.

If an appointment already exists in Outlook, it 
is updated. The appointments are marked in 
Outlook as "Appointment in Infor 
CloudSuite."
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Contacts

Adding Contacts in Outlook

To add a contact in Microsoft Outlook that will be synchronized to Infor CloudSuite:

1 In Outlook, add a new contact.

2 Fill in the fields for the contact:

The information in these fields will be synchronized to Infor CloudSuite:

 First Name - required, first 15 characters only

 Last Name - required, first 15 characters only

 Middle Name - optional, first character only

 Job Title - optional

 E-mail - optional

 Business Phone - required

 Home Phone - optional

 Business Fax - optional

 Mobile Phone - optional

 Business Address - optional. Some parts of the address are validated against information 
in the Infor CloudSuite database. For example, if you enter the country as "USA" and Infor 
CloudSuite does not have a country set up called "USA" an error is displayed.

 Salesperson - optional

3 In the Infor CloudSuite pane, select Contact in Infor CloudSuite.

4 Save the new contact without closing the window.

5 Click Sync Out on the Infor CloudSuite menu to immediately save this contact in the Infor 
CloudSuite contacts. (If you have not yet saved the contact, the system prompts you to save the 
contact first.) You can also wait and later Sync Out all changes to your contacts at one time, using 
the Outlook Contact option on the Infor CloudSuite menu. 

Or you can set the toolbar ribbon option to Enable Auto Sync Out so that any addition or update 
to a Infor CloudSuite contact in Outlook is automatically synchronized to Infor CloudSuite as soon 
as you save the contact in Outlook.

6 You can optionally click the Contact X-Ref button to associate a Infor CloudSuite salesperson, 
customer, and prospect with this contact.
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7 If you selected a salesperson, the Infor CloudSuite Opportunities field shows the opportunities 
associated with the salesperson and contact, if the selected contact is a Infor CloudSuite contact. 
Otherwise, the opportunities associated with the salesperson are displayed.

The Infor CloudSuite Opportunities area is refreshed each time you open the contact window or 
select a different salesperson name.
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The resulting information is shown in the Infor CloudSuite Sales Contacts form.

The salesperson is added to the Salesperson Cross-Reference for that contact.

Adding Contacts in Infor CloudSuite

To add a contact in Infor CloudSuite that will be synchronized to Outlook:

1 In Infor CloudSuite, open the Sales Contacts form.

2 Select Actions > New and fill in the information about the contact:
The information in these fields will be synchronized to Infor CloudSuite:

 First Name - required, first 15 characters only

 Last Name - required, first 15 characters only

 Middle Initial - optional

 Job Title - optional

 E-mail - optional

 Business Phone - required

 Home Phone - optional

 Business Fax - optional

 Mobile Phone - optional

 Business Address - optional.
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3 Save the information.

4 Click the MS Outlook Sync Out button to duplicate the contact information in Microsoft Outlook.

5 The contact is added to Outlook, and the Contact in Infor CloudSuite check box is selected for the 
contact.

Updating Infor CloudSuite Contact Information in Either System

After Infor CloudSuite contacts are set up and synchronized so that they appear in both systems, you 
can update the information in either system and click the appropriate Sync Out button to duplicate 
the changes in the other system. Or, go to the other system and click the appropriate Sync In button 
to pull in all new or changed Infor CloudSuite contacts.

Deleting Contacts in Either System

If you delete a contact in either Outlook or Infor CloudSuite, the contact is not deleted when you 
perform a Sync In or Sync Out. You must manually delete the contact.

Viewing Sales Contacts in Outlook

When you open a contact in Outlook, a subset of the Infor CloudSuite Sales Contacts form is 
displayed in the Outlook Contacts tab, if:

 You enabled Display Infor CloudSuite Sales Contacts form in Outlook Contact in the Infor 
CloudSuite Add-in, as described in “Setting Up the Add-in in Outlook” on page 65.

 The contact is marked in Outlook as a "Contact in Infor CloudSuite."

 SyteLine users have a SyteLineOfficeIntegration license.

 Infor CloudSuite Industrial users have an OfficeIntegration license.

 You have a Infor CloudSuite login. The "Use workstation logon" setting should be set up for this 
user in Infor CloudSuite, so that no login screen is displayed in Outlook.

This Sales Contacts form is displayed filtered on the current contact name. The Customer Bill-Tos, 
Prospects, Salespersons, and Interactions tabs all contain display-only information. On the 
Preferences tab, you can set or change contact preferences; then right-click in the form and select 
Save to save your changes.
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Tasks

Adding Tasks in Outlook

To add a task in Microsoft Outlook that will be synchronized to Infor CloudSuite:

1 In Outlook, select create a new task. This is performed differently depending on the version of 
Outlook you are using.

If you have outstanding tasks saved in Infor CloudSuite, these display in the Infor CloudSuite 
pane.

2 Fill in the fields for the task.

The information in these fields will be synchronized to Infor CloudSuite:

 Subject - required, first 80 characters

 Reminder Date/Time - required

 Description - optional

3 In the Infor CloudSuite pane, select Task in Infor CloudSuite.

4 If you want the task to be automatically deleted from Infor CloudSuite after the reminder has been 
sent, select Delete After Reminder. The task will not be deleted from Outlook.

5 Save the task.

6 Click Sync Out in the Task toolbar ribbon to immediately save this task in your Infor CloudSuite 
task list. (If you have not yet saved the task, the system prompts you to save the task first.) You 
can also wait and later Sync Out all changes to your tasks at one time, using the Sync Out All 
button on the Infor CloudSuite menu. 

You can set the toolbar ribbon option to Enable Auto Sync Out so that any addition or update to 
a Infor CloudSuite task in Outlook is automatically synchronized to Infor CloudSuite as soon as 
you save the task in Outlook. This option defaults to the setting in the Tools > Options dialog box 
and can be overridden either here or in the Tasks pane.
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The resulting information is shown in the Infor CloudSuiteTask List form:

Adding Tasks in Infor CloudSuite

To add a task in Infor CloudSuite that will be synchronized to Outlook:

1 In Infor CloudSuite, select View > Task and fill in the fields on the Create User Task form:

The information in these fields will be synchronized to Outlook:

 Task Name - required, first 80 characters

 Reminder Date/Time - required. Use the drop-down calendar to select a date and accept 
the default time of 12 a.m., or enter a date and time manually.

 Description - optional.

2 If you want the task to be automatically deleted from Infor CloudSuite after the reminder has been 
sent, select Delete After Reminder.

3 Click OK to save the task.

4 Open the Task List, select the task, and click the MS Outlook Sync Out button to duplicate the 
task information in Microsoft Outlook.

5 The task is added to Outlook, and the Task in Infor CloudSuite check box is selected for the task.
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The resulting task is displayed in your To-Do List in Outlook.

Updating Task Information in Either System

After Infor CloudSuite tasks are set up and synchronized so that they appear in both systems, you 
can update the information in either system and click the appropriate Sync Out button to duplicate 
the changes in the other system. Or, go to the other system and click the appropriate Sync In button 
to pull in all new or changed Infor CloudSuite tasks.

Deleting Tasks in Either System

If you delete a task in either Outlook or Infor CloudSuite, the task is not deleted when you perform a 
Sync In or Sync Out. You must manually delete the task.

Calendar Appointments

Adding Appointments in Outlook

To add a calendar appointment in Microsoft Outlook that will be synchronized to Infor CloudSuite:

1 In Outlook, create a new appointment. This is performed differently depending on the version of 
Outlook you are using.

If you have outstanding Infor CloudSuite-designated appointments, these display in the Infor 
CloudSuite pane.

2 Fill in the fields for the appointment.

The information in these fields will be synchronized to Infor CloudSuite:

 Subject - optional, first 80 characters

 Location - optional, first 80 characters

 Start Date/Time - required

 End Date/Time - required

 Reminder Date/Time - optional. The reminder time specified in the Outlook toolbar (as 
shown below) is subtracted from the Outlook Start Time to build the Infor CloudSuite 
Remind Date. For example, if the Outlook reminder time is 15 minutes and the Start Time 
is Wed 2/17/2010 3:00 PM, the Infor CloudSuite Remind Date is set to 2/17/2010 
02:45:00 PM.

 Description - optional, truncated to the length of the Description field in Infor CloudSuite.

3 In the Infor CloudSuite pane, select Appointment in Infor CloudSuite.
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4 If you want the appointment to be automatically deleted from Infor CloudSuite after the reminder 
has been sent, select Delete After Reminder. The appointment will not be deleted from Outlook.

5 Save the appointment.

6 Click Sync Out in the "Infor CloudSuite Appointments" toolbar ribbon to immediately save this 
appointment in your Infor CloudSuite User Calendar. (If you have not yet saved the appointment, 
the system prompts you to save the appointment first.) You can also wait and later Sync Out all 
changes to your appointments at one time, using the Sync Out All button on the Infor CloudSuite 
menu. 

You can set the toolbar ribbon option to Enable Auto Sync Out so that any addition or update to 
a Infor CloudSuite appointment in Outlook is automatically synchronized to Infor CloudSuite as 
soon as you save the appointment in Outlook. This option defaults to the setting in the Tools > 
Options dialog box and can be overridden either here or in the Appointments pane.

The resulting information is shown in the Infor CloudSuite User Calendar form:

Adding Appointments in Infor CloudSuite

To add a calendar appointment in Infor CloudSuite that will be synchronized to Outlook:
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1 In Infor CloudSuite, open the User Calendar and double-click on the day the appointment should 
take place:

2 In the Create User Appointment form, specify the information about the new appointment:

The information in these fields will be synchronized to Outlook. For all date/time fields, use the 
drop-down calendar to select a date and accept the default time of 12 a.m., or enter a date and 
time manually.

 Subject - optional, first 80 characters

 Location - optional, first 80 characters

 Start Date/Time - required

 End Date/Time - required

 Reminder Date/Time - optional.

 Description - optional.

3 If you want the appointment to be automatically deleted from Infor CloudSuite after the reminder 
has been sent, select Delete After Reminder.

4 Click OK to save the appointment and return to the User Calendar.

5 In the grid side of the User Calendar form, select the row for the appointment you created. Click 
MS Outlook Sync Out to duplicate the task information in Microsoft Outlook.

6 The system tells you that an Outlook appointment(s) export will be performed. Click OK.

7 The system tells you how many appointments were added or updated in the Microsoft Outlook 
Calendar folder.Click OK.

8 The appointment is added to Outlook, and the Appointment in Infor CloudSuite check box is 
selected. The resulting appointment is displayed in your Outlook Calendar:
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Updating Appointments in Either System

After Infor CloudSuite appointments are set up and synchronized so that they appear in both systems, 
you can update the information in either system and click the appropriate Sync Out button to 
duplicate the changes in the other system. Or, go to the other system and click the appropriate Sync 
In button to pull in all new or changed Infor CloudSuite appointments.

Deleting Appointments in Either System

If you delete an appointment in either Outlook or Infor CloudSuite, the appointment is not deleted 
when you perform a Sync In or Sync Out. You must manually delete the appointment.

Service

Creating an Incident from an Outlook Message

1 Open the Outlook message that you want to use to create an incident, or click New Incident.

2 Specify this information: 

 Interaction Type: Select Incident.

 Priority: Select a code to indicate the level of priority for the incident. 

 Status: Select a status for the incident. 

 SSR: If the current user is a SSR, the username is displayed by default. Otherwise, click the 
ellipsis button to open the Search screen and search for a SSR.

 Customer: Select a customer using the Search screen. If the email address from the Outlook 
message is associated with a customer, that customer is displayed by default.

 Add Attachment: Optionally, select this check box to include any attached documents. 

 Document Type: When including an attachment, select the document type for the 
attachment. 

 Subject: The subject of the email message is used by default and is truncated to the first 40 
characters. Optionally, specify a different subject. 

3 Optionally, select Mark as Internal to set the incident as internal. 

4 Click Submit. The message is flagged with a new icon to indicate that it was converted to an 
incident. The incident is generated in Infor CloudSuite Industrial and the Incident field in the 
Email Interaction pane is updated with the new incident number. 
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Creating an Event from an Outlook Message

1 Open the Outlook message that you want to use to create an event, or click New Event. The 
message must already have an incident associated with it. 

2 Specify this information: 

 Interaction Type: Select Incident.

 Incident: Click the ellipsis button to open the Search screen and search for an incident. If you 
are using an email message that contains an incident number or that you previously 
converted to an incident, that incident number is displayed by default. 

 New Event: Select this check box. 

 Event Code: Select an event code. 

 Follow-up Date: Select a follow-up date for the event. An automatic reminder is added for the 
email, if applicable. 

 Add Attachment: Optionally, select this check box to include any attached documents. 

 Document Type: When including an attachment, select the document type for the 
attachment. 

 Mark Note as Internal: The email message is attached to the event as a note. Select this 
check box if you want to use the note for internal purposes only. 

 Subject: The subject of the email is used by default and is truncated to the first 40 characters. 
Optionally, specify a new subject. 

3 Click Submit. A message is displayed saying that the message has already been added to an 
incident. Click Yes to continue. The message is flagged with a new icon to indicate that it was 
converted to an event.

Adding a Note to an Incident

1 Select an email message. The message must not be flagged with the New Incident icon. 

2 Click Add Note. The email is opened and the Interaction Type is set to Incident. 

3 To create a new incident for the note, select New Incident. 

4 To add the note to an existing incident, click Search to open the Search Incidents form and select 
an incident. All incidents associated with the current SSR are displayed. Select the incident, then 
click Select and Close. 

5 Click Submit. A message is displayed saying that a message has been attached to the note. 

Smart Match

The add-in uses a smart matching feature to detect an incident number inside an email message or 
subject when the message is opened in read mode. The incident number is automatically selected 
and displayed in the interaction pane. If multiple records are detected, an asterisk (*) is added to the 
Incidents field label, indicating that multiple matches exist. All matches are displayed in the grid when 
you click Search. 
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You can disable smart match as described in Setting Up the Add-in in Outlook. 

Customer, Vendor, Prospect, and Sales Contact Interactions

Adding Outlook E-mails to Infor CloudSuite Interactions

In Infor CloudSuite, interactions are used to keep track of information about any encounters with a 
customer, vendor, prospect, or sales contact; for example, e-mails, phone calls, and faxes.

You can add incoming and outgoing Outlook e-mails to the Infor CloudSuite Customer Interactions, 
Vendor Interactions, Prospect Interactions, and Sales Contact Interactions forms. When you 
open a received or sent email, the Infor CloudSuite add-in form is displayed below the reading pane 
when you open the message in Outlook.

Example

The next five numbered steps detail how to add a message to the Infor CloudSuite Customer 
Interactions form. This is an example that can be used to understand how you can also add a 
message to the Vendor Interactions, Prospect Interactions, and Sales Contact Interactions 
forms.

To add the message to the Infor CloudSuite Customer Interactions form:

1 You can attach the message to an existing interaction, or create a new interaction:

 To attach the message to an existing interaction, first select a customer, then search for an 
existing interaction. You can provide other details if needed. When you select a customer, the 
customer number, ship-to number, and customer name are displayed. The Outlook add-in 
locates the existing interaction using the reference number (for example, Customer, Vendor) 
and the email subject.

 To create a new interaction, select Create New Interaction. The additional fields Choose 
Topic and Description display. If you select a topic from the available list, the Description 
contains the e-mail subject. Alternately you can write your own description..

Note: In this example, the add-in tries to set a default value for the Customer field based on the 
sender’s e-mail address. If the e-mail address matches either a Primary Contact or Secondary 
Contact e-mail address in the Infor CloudSuite Customers form, then the matching customer name is 
placed in this field.

Note: In SyteLine version 8.03, the Vendor Interactions, Sales Contact 
Interactions, and Propect Interactions forms had no e-mail 
functionality at all, so you must be at least up to version 9.00 to 
realize that functionality for those forms.
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When you are sending an e-mail, the add-in tries to provide a default value by matching the first 
address on the To line with a primary or secondary contact e-mail address in the Infor CloudSuite 
Customers form. If no match is found, the add-in looks through the Customer contact table. If 
multiple matches are found, the add-in will pick the first record. An asterik(*) will suffix the 
customer label to indicate that there are multiple matches.

2 Use the Search button to find a Ship-To name for the customer.

3 Select a follow-up date, or keep the default of today’s date.

4 Click Submit.

5 You will see a prompt confirming that the message was attached to the interaction.

The resulting attachment in the Infor CloudSuite Customer Interactions form looks like this:

These fields from the Outlook e-mail are included in the interaction:

Outlook field Infor CloudSuite field

Incoming e-mail or
Sent item

Incoming (selected for incoming e-mail; not 
selected for sent item)

N/A Type (E-mail)

Create date/time (sent e-mail) Contact date/time

From From

To To

Cc Cc

Follow Up Follow-Up Date

Subject Subject (80 characters)
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If the Outlook e-mail is formatted using HTML, or if it contains special characters or formatting, the 
formatting may not be compatible with Infor CloudSuite note formatting. In that case, the special 
formatting is ignored, and additional spacing may appear in the interaction record.

Sending E-mail Attachments

If the e-mail you want to send to Infor CloudSuite has an e-mail attachment or attachments, you can 
send that e-mail along with the attachments.

If the e-mail has an attachement, an additional group box is displayed in the form below the reading 
pane.

To send the e-mail attachment to Infor CloudSuite:

1 Select the Include Attachment(s) check box. This check box is cleared by default.

2 Select a document type from the list. You can read more about document types in the Infor 
CloudSuite online help regarding the Document Types form.

3 Click Submit.

Viewing Outlook E-mails with Infor CloudSuite Interaction Details

After an e-mail is associated with a customer, vendor, prospect, or sales contact, an additional pane is 
displayed at the bottom with interaction details. This lets you easily refer to recent orders or 
communications when you contact the customer, vendor, prospect, or sales contact without requiring 

Message Message

Customer (from add-in form) Customer

Ship-To (from add-in form) Ship-To

Contact Id (retrieved from email id match) Contact Id 

Outlook field Infor CloudSuite field
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you to log into Infor CloudSuite to research this information. The bottom pane for each type of 
interaction is similar. This is what the customer interaction type looks like:

The bottom pane for the customer interaction type contains: 

 Order header information: order number, date, status, and order total. These are sorted based on 
order number. The maximum number of orders that display is based on the default record cap 
limit set in Infor CloudSuite.

 Order details: order line, item, quantity ordered, and unit price, filtered based on what you select 
in the order header section.

 Interactions: interaction date, topic, contact name, status, follow-up date, sequence, incoming flag 
(Y for incoming and N for sent items), contact date, and name of the Infor CloudSuite user. These 
are sorted based on contact date. The maximum number of interactions that display is based on 
the default record cap limit set in Infor CloudSuite. When you select an interaction from the grid, 
the contents of the interaction are displayed in the right pane.

 The panes for the other interaction types contain information appropriate to those types.

If you close this pane, the only way to reopen it is to close and reopen the e-mail.

Viewing E-mail Attachments in Infor CloudSuite

The procedure detailed here is for the Customer Interactions form. You can also view e-mail 
attachments on the Vendor Interactions, Prospect Interactions, and Sales Contact Interactions 
forms.

To view e-mail attachments sent to Infor CloudSuite in Infor CloudSuite:

1 Open the Customer Interactions form.
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2 Select the interaction row on the Conversations tab with the desired e-mail attachment.

3 Select Actions > Documents for Current from the menu bar. The Attached Documents form is 
displayed.

Using SmartLink with Outlook E-mails

If all of the following are true:

 You specified the Web Client URL and enabled SmartLink in the Infor CloudSuite add-in, as 
described in “Setting Up the Add-in in Outlook” on page 65.

 You clicked the link in the add-in to define your search preferences in Infor CloudSuite.

 You are opening an e-mail message in Outlook from an e-mail address that belongs to a group 
that is defined in your search preferences.

 The "Use workstation logon" setting is set up for this user in Infor CloudSuite, so that no login 
screen is displayed in Outlook.

Then SmartLink compares all of the text in the e-mail to the Infor CloudSuite data sets that are 
defined in your search preferences. If it finds matching text in the e-mail, SmartLink adds a hyperlink 
to the text, like this:

Click the link to open the appropriate Infor CloudSuite form, filtered to show the value indicated by the 
link. You must have the appropriate Infor CloudSuite license/authorizations to open the form.
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Example Setup

In order for the example shown above to display that link, the following setup must be done on the 
Infor CloudSuite side: 

 The sender’s e-mail address is defined in the Infor CloudSuite Customers form as an external or 
internal e-mail address.

 In the Search Items form, the ItemNum search item is defined as:

Active = enabled
Table Name = item
Column Name = item
Form Name = Items

That is, search for matching text in the item.item table/column (which maps to the item number 
field on the Items form). If it finds a match, SmartLink builds a hyperlink to the Items form, filtered 
on the matching item number.

 In the Search Preferences form, this row exists for the Outlook user receiving the e-mail: 

Search Group = CUSTOMER and Search Item Name = ItemNum

That is, if the sender’s e-mail address is found in the CUSTOMER Search Group (which maps to 
the external and internal e-mail addresses from the Customers form), then search for matching 
text in the search item named ItemNum.

For more information about defining search preferences and search items, see the Infor CloudSuite 
help.

Using the Data-Grid Pane

The Infor CloudSuite data-grid pane is located below the Interaction pane. The Infor CloudSuite data-
grid pane gives a quick access to the information related to the people you work with or exchange the 
message with. The people can be anyone from customers, vendors, contacts or prospects. If you 
don't work with all of these, you can turn them off selectively from the Add-In Options, so the data-grid 
won't be visible to you. You can also just close the grid pane.

The data-grid pane is not always visible when a message is opened. It is visible only when the 
sender's email id matched in a Infor CloudSuite database against the Interaction Type or the existing 
message has previously been attached to any of the above Interaction Types. Depending upon the 
match, the data-grid shows different data.
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Data-Grid Example for Customer

The grid looks similar but has different data for Vendor, Prospect, and Contact.

Replacing a Data-Grid with a Custom Infor CloudSuite Form

The default Data-Grid can be replaced with a Infor CloudSuite custom form. SyteLine users must be 
assigned the SyteLineOfficeIntegration license to replace a data-grid with a custom Infor CloudSuite 
form. Infor CloudSuite Industrial users must be assigned the OfficeIntegration license. The form is 
displayed in ‘form only’ mode.

To replace the data-grid with a custom Infor CloudSuite form:

1 Right-click on the grid or outside area then select Settings. The Settings window is displayed.

2 Select Custom Form.

3 From the drop-down list, select the form with which you want to replace the data-grid.

Hiding and Showing Infor CloudSuite Custom Panes

You can show and hide the custom panes. The pane displays by default for email, task, contact, and 
calendar items.
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Hide Panes

Click the X (Close) button to close the pane. All of the available panes can be closed in this manner.

Show Panes

When the pane is closed, to view it again, click on the button in the toolbar labeled “Show Data Grid 
Pane.”

Using the Search Button

The interaction pane contains two Search buttons.

Search Button 1

This is the button below the Submit button.

The Search button performs a search for both Customer or Prospect if either is displayed in the 
Interaction Type field, and the results are placed in the result grid on the Interaction Search window 
that displays. Results for Vendor and Contact are displayed separately on their own tabs.
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1 Click the Search button below the Submit button to search for customer, prospect, contact or 
vendor, depending on what is selected in the Interaction Type field. The Interaction Search 
window is displayed.

This window has three tabs, Customer/Prospect, Contact, and Vendor. The appropriate tab is 
selected based on your search criteria, and any search results are seen in the grid.

This window performs an automatic search when opened based on the following conditions:

 Incoming email: The reference number (Customer, Vendor, Prospect, Contact) is defaulted 
automatically when an incoming email is opened.  If the add-in finds multiple records matching 
the sender’s email id, an asterisk (*) is placed next to reference label (for example, Customers*, 
Prospects*) to indicate the multiple result. The multiple result is automatically displayed in the 
search window when you click the Search button.

 Outgoing email: The search can be performed only when a receiver’s address is entered. The 
add-in uses the first email id when multiple email addresses are entered. The add-in performs an 
automatic search using the receiver’s email, and the result is placed in the result window when 
you click the Search button.

2 Supply information into any of the fields on this Interaction Search window and click the Search 
button to further narrow your search.

3 Select the result you were searching for and click Select and Close.

Search Button 2

This is the search button that is NOT under the Submit button.
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1 Click this Search button. The Search Existing Interaction window is displayed.

You can attach an email message to an existing interaction or a new interaction id. You can search 
by Interaction ID, Description, Interaction Date, Topic, Topic Description, and Follow up Date.

2 Supply information into any of the fields on this Search Existing Interaction window and click the 
Search button to further narrow your search. Any existing interactions are displayed in the grid.

3 Select the interaction you were searching for and click Select and Close.

Incident Search

When Incident is selected as the Interaction Type, click Search to open the Search Incidents 
window. As with the customer and prospect Interaction Types, the results are displayed in a grid and 
you can select the interaction you were searching for. You can perform three types of searches:

 Smart Search: The Search Incidents window automatically searches for and locates incident 
numbers in an email message or subject. The Search Incidents window scans the message and 
subject for a pattern using the regular expression to detect any incident numbers included in the 
message. 

 Owner Search: The Search Incidents window automatically filters for all of the latest and open 
incidents that belong to the current user.

 Field Search: You can perform a more advanced search by entering in the other fields available 
on the Incidents Search window, such as Description, SSR Name, and Owner Name. 

SSR Search

For Incident Interaction Types, you can perform a search based on the SSR code and name. Click the 
ellipsis button next to the SSR field in the interaction pane. You can search for the code or the name 
or both. The results are displayed in the grid and you can select the interaction you were searching 
for. 
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Cross Referencing Customer, Prospect, and Salesperson from 
Outlook Contact

The 'Contact X-Ref button is displayed on the top menu of the Outlook Contact ribbon. This graphic 
shows the button and grids inside the custom pane.

The existing reference is displayed on the custom pane on the right-hand side. The displayed grids 
include Customer, Prospects, and Salespersons. The opportunity grid displays every item that is 
associated with a Salesperson. This grid is refreshed when you select a different salesperson from 
the grid.
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Adding a New Cross-Reference

1 Click the Contact X-Ref button. The Contact X-Ref window is displayed.

The bottom grid shows any existing reference already added to the contact. The top grid shows 
the search result.

2 Optionally provide search criteria into any of the fields and click the Search button. Customers 
and prospects are combined in the search. Salesperson is a separate search.

3 Select the appropriate record in the top grid. On the Customers/Prospects tab, the Type column 
defines whether the record is for a customer or a prospect. Type ‘C’ is customer. Type ‘P’ is 
prospect. On the Salesperson tab, there is no need for a type column.

4 Click the Apply Selection button.
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Sending and attaching a New Email to an Interaction

You can attach a new email message to Infor CloudSuite interactions before sending. The Send and 
Submit button is displayed for new email messages and when you reply to messages.

When you click this button, it sends the email message and attaches the email to the selected 
interaction at the same time. The email message is not attached to the Infor CloudSuite interaction if 
you use the Outlook Send button to send the email.

Using the Ref Type field

The Ref Type field is an optional field. Choose a reference type from the Ref Type field to go along 
with the interaction type in the Interaction Type field. The selected reference is sent to Infor 
CloudSuite along with the interaction and is displayed when the interaction is opened either from 
Outlook or Infor CloudSuite.

This area looks a bit different if the message has an attachment. In this case, the Reference section is 
collapsed.

Click +REF to expand the section. This is a toggle key. The attachment section is moved right when 
the reference section is expanded, and a scroll bar displays so you can scroll to see all contents.
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This table displays the reference types available for each interaction type and the IDO read and 
execute access required. Note that the Contact interaction type isn’t listed. This is because this 
feature is not available for that interaction type.

Selecting a reference number

1 To select a reference number, click the search button to the right side of the number field. An 
Interaction Type and value (for example, Customer, Vendor, etc.) must be selected prior to 

Interaction Type Reference Type IDO read and execute access 

required.
Customer Opportunity SLOpportunities

Item SLItems

Lead SLLeads

Estimate SLCOs

Estimate Project SLProjs

Customer Order SLCOs

Project SLProjs

Prospect
Lead SLLeads

Opportunity SLOpportunities

Estimate
Estimate Project SLProjs

Vendor
Item Price Request SLItemPriceRequests

Purchase Order SLPOs

Item SLItems
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selecting the reference number. This search window is displayed based on the reference type 
selected.

2 Enter the appropriate search criteria then click Search to show the result.  You can change the 
reference type from this window if you wish.
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Using the Infor CloudSuite Explorer in Outlook

The Infor CloudSuite add-in creates a new Infor CloudSuite Explorer module that is displayed in the 
Outlook Navigation pane. When you select it, the Explorer folders display in the pane above, and the 
available forms are listed in the pane to the right.

By default, forms open in an Outlook window; however, you can change the add-in settings so that 
forms open in a separate Web browser window. In that case, they open in your default browser, such 
as Internet Explorer, Firefox, etc.

The forms display from the Infor CloudSuite server and configuration that you specified in the Add-in 
Options dialog.

Adding, Deleting and Changing Folders and Forms in the Explorer

Initially, certain CRM and Salesperson folders and forms are included in the Explorer. 

You can right-click to add, remove, or rename folders in the folders pane.

To add a new form to a folder:

1 Right-click on the folder and select Add New Infor CloudSuite Form.

2 In the Infor CloudSuite Form Link dialog, specify this information:

 Form Name: Select a Infor CloudSuite form from the drop-down list.
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 Form Caption: To display a form caption in the right pane that is different from the default form 
name, specify it here. For example, if you set a filter on the Customer Orders form to show 
only customer orders that you are responsible for, you could rename it "My Customer Orders."

 Form Filter: Set any filter condition to be applied when the form opens. For example, if you 
are salesperson "BJS" and you want to filter your version of the Customer Orders form to 
show only your orders, specify the filter Slsman = ’BJS’. (Use Infor CloudSuite to determine 
the appropriate filter, as described in “Finding a Property Name to Use in a Filter.")

3 Click OK.

Finding a Property Name to Use in a Filter

Filters require you to specify a property name. If you do not know the underlying property names used 
on a form, here is the simplest way to find them:

1 In Infor CloudSuite, open the form with filter-in-place.

2 Specify the filter you want - for example, on the Customer Orders form, enter BJS in the 
Salesperson field - and then click the filter button on the toolbar. Only orders where the 
salesperson is set to BJS are displayed.

3 Select Help > About this Form.

4 In the About this Form dialog, find the User-Specified Filter - in our example, 
Slsman = ’BJS’.

5 In Outlook, type the user-specified filter from Step 4 into the Form Filter field of the Infor 
CloudSuite Form Link dialog box in Outlook. 
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3Chapter 3: Mongoose Application Search 
Service for Microsoft Office 
Products

Overview
You can use Mongooes Application Search to search and access Infor CloudSuite data directly from 
Microsoft Office 2010 or 2013 applications such as Outlook and Word. To set up this feature in the 
Office application, you simply register a URL to the Mongoose Application Search Web service; no 
installation is needed on the client side. You must also have an Infor CloudSuite or SyteLine login and 
license.

Search Example

In Microsoft Outlook, you receive an e-mail that references item FA-10000. You recognize that this is 
a Infor CloudSuite item, but you are not sure what that item is and you need to find a description of it. 
Select the text FA-10000 in the e-mail. Right-click and select Look up, or Alt-click on the text.

If appropriate search rules have been defined in Infor CloudSuite - in this case, for a search on the 
items table - then the Office application’s Research task pane displays the results of the Infor 
CloudSuite database search for references to FA-10000. The results include a result title (in this case 
the item description text for FA-10000), a result description (the item’s overview text), and a link to a 
Infor CloudSuite form.

If you click the link, the Infor CloudSuite Items form, filtered for FA-10000, displays in a Web browser. 
You can use the form to find out more information about the item.

You can also right-click in an Office document, e-mail or spreadsheet and select Look up with nothing 
selected. Then you enter search text directly in the Research pane. For more information about what 
text you can enter, see “Searching for Information” on page 111.
Infor CloudSuite Industrial - Microsoft Office Integration User Guide | 107



  
Behind the Scenes

On the Infor CloudSuite side, administrators must define the search rules: 

 Use the Search Items form to specify the search items - that is, the types of information that 
Office users can search for, such as Item Number or Customer Name, and the database table and 
column that is searched when that information type is requested.

The Search Items form also specifies the result that the Office user sees: the form name used in 
the link, and the columns from the database that are returned as the search result title and 
description.

 The tables that are used to define search items require unique full-text indexes, which are set up 
through the Infor CloudSuite Full-Text Indexing form and associated with the SearchCatalog 
catalog. 

This diagram shows the system processing that occurs when a user requests a search for Infor 
CloudSuite data from any Office application:

The Infor CloudSuite Application Search Web Service (also known as the Search Service) is installed 
on a Infor CloudSuite web/utility server. The Search Service corresponds to a "provider" and can 
process search requests, each of which corresponds to a "service." The Research Task service 
sends the search request to the "provider" when the user searches for a term. Then the "provider" 
processes the request using the Infor CloudSuite application database, via an IDO Web Service 
method call. The search result created by the method is then returned to the Research Task service. 

All communication between the research task pane and the Web service uses SOAP messages. 
These SOAP messages contain XML packets that conform to schemas specific to each type of 
request and response. 

Requirements
To use the Search feature, ensure that these requirements are met:

 You are using Microsoft Office 2010 or 2013.
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 You are using SyteLine 8.03 or later version.

 The IDO Request Web Service and the Infor CloudSuite Application Search Web Service options 
are installed on the Infor CloudSuite utility/web server.

 The account that the Search Web Service runs under must have read and write permissions to 
create a file in the folder where the service executable file is installed. If those permissions are not 
granted, give them to any user who will use the search feature. Give those permissions to the 
folder typically located here (you may have installed it to a different location): 
C:\inetpub\wwwroot\ApplicationSearchServiceForOffice. This folder is created on the utility server 
during the initial setp of Infor CloudSuite. If the folder does not exist, run the Infor ERP SL 
Configuration Wizard on the utility server and add the Application Search Service for Office 
component. See the Infor CloudSuite Installation Guide for instructions on how to add that 
component.

 SyteLine users must be assigned a SyteLineAutomation license. Infor CloudSuite Industrial users 
must be assigned an Automation license. For more information about this license type, see the 
Infor CloudSuite Industrial Licensing guide.

 You must have a user account on the Infor CloudSuite configuration to which the Search Service 
will connect.

Note: The "Use workstation logon" setting should be set up for this user in Infor CloudSuite, so 
that no login screen displays when you click on a link to display a form.

 This Infor CloudSuite user account must be set up with Execute and Read privileges on the IDO 
object SearchItems.

 A system administrator must set up appropriate search items and full-text indexing of tables in 
Infor CloudSuite. For more information, see the Infor CloudSuite online help topic about setting up 
search items for Mongoose Application Search.

Setting Up the Search Service
Use these steps to set up the Search Service in your Microsoft Office application. You can set this up 
in one Office application and then it is available to all other Office applications.

Note: If any of these steps fail, verify that you have met all the requirements listed above.

Registering the Search Service

To register the service in your Office application:

1 Ask your Infor CloudSuite system administrator for the URL to connect to the Search Service.

2 Use the help in your Office application to determine how to access the Research Options dialog 
box.

For example, to access Research Options in Outlook, you might open an e-mail message, right-
click anywhere in the message body and select Look up > Research Options.
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3 In the Research Options dialog box, click Add Services.

4 Specify the URL of the Search Web Service, for example:
http://server/ApplicationSearchServiceForOffice/SearchService.asmx

The registration is processed and returns an introduction message about the service.

5 Click Continue.

6 In the Setup dialog box, ensure that the Mongoose Application Search Service is selected and 
click Install.

7 After the service is registered, a success message displays.

8 Make Infor CloudSuite Application Search Service your default search provider. From the 
Research Options task pane, select Mongoose Application Search and click the Favorite 
button.

Configuring the Search Service

Infor CloudSuite data can be searched only by authorized Infor CloudSuite users. You must set up a 
valid Infor CloudSuite user name and password. 

1 When you make a search request for the first time from an Office application, this window 
displays:

2 Specify this information:
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 Infor CloudSuite user name and password

 IDO Web Service URL, for example:
http://server/IDORequestService/IDOWebService.asmx

 Infor CloudSuite configuration name. You must click Load Config Names before you can 
select a configuration.

 Web Client URL, for example:
http://server/WSWebclient/default.aspx
This is used to format the link URL on the result set.

3 Click Save.

A success message displays. You are ready to perform searches.

Removing or Reconfiguring the Search Service

After registration, the Search Service is listed as Mongoose Application Search Service service 
under the Enterprise Resources category in the Office application’s Research Options dialog box. 

To remove the service, use the Update/Remove button on the dialog box.

To reconfigure the service, click the Config link on any search results window. 

Searching for Information
After the Search Service is set up, you can use the Research task pane in your Office application to 
search for information. 

1 Use the Office application help to determine how to display the Research pane. 

For example, in Outlook, you might select some text in an e-mail, right-click and select Look Up, 
or hold down the Alt key and click on the text, to display the Research pane.

2 If you selected text in a document or e-mail, that text displays in the "Search for" field. You can 
also manually enter text into the "Search for" field. 

You can search for one word, multiple words, phrases, or Boolean combinations of words:

 If you enter multiple words, the search looks for each word separately. For example, entering 
mountain bicycle returns these results: Configurable Mountain Bicycle, Bicycle with 
Mountain Tires, and even Bicycle with Hybrid Tires.

Results might not contain the words in the same order or even use all the specified words; 
however, results with more matching words in the correct order are more relevant and display 
near the top of the result set. 

 If you enter single or multiple words, the search tries to match the meaning of the text, rather 
than exact letters. For example, race bike also returns Configurable Racing Bicycle.
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 If you enter a phrase surrounded by double quotation marks, the search looks for the 
combined phrase. For example, entering "mountain bicycle" returns Configurable 
Mountain Bicycle but not the other two results listed in the previous example.

Phrases are also useful when your search text includes a special character such as a hyphen. 
For example, if you specify FA-10000, the search ignores the hyphen and finds results for 
both FA and 10000, including results such as FA-12035 and FC-10000. To retrieve only 
matches for FA-10000, specify it as a phrase: "FA-10000".

 If you combine words by using Boolean operators (OR, AND, and AND NOT), then the exact 
letters are searched for. For example, bicycle AND blue will find results that contain both the 
word bicycle and the word blue. Bicycle AND NOT Tires returns Configurable Mountain 
Bicycle, but not Bicycle with Mountain Tires or Bicycle with Hybrid Tires.

Place Boolean operators between single words or phrases. For example:

 Not Correct: Bicycle AND NOT mountain tires

 Correct: Bicycle AND NOT "mountain tires"

Search Results

Up to 10 matching search results are displayed in the Research task pane. If additional results are 
available, you can navigate to them.

Click on a link in the search results to open the related Infor CloudSuite form where you can find more 
information. (The "Use workstation logon" setting should be set up for your user ID in Infor 
CloudSuite, so that no login screen displays when you click on a link to display a form.)

If no results are available for the text you specified, a message displays.
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4Chapter 4: Microsoft Project Add-In for 
Infor CloudSuite

This section describes how to install and use the Microsoft Project Add-In so that you can integrate 
with Infor CloudSuite. This Add-In allows you to pull in data from Infor CloudSuite and also to send 
data from Microsoft Project to Infor CloudSuite.

Requirements
 You are using Microsoft Project version 2010 or 2013.

 You are using SyteLine version 8.03 or later version, up to Infor CloudSuite Industrial 9.01.00

 The latest Windows and Office Updates.

 The IDO Request Web Service option was installed with the Infor CloudSuite utility/web server.

 You must be logged in as an administrator on the computer where you are installing the Project 
Add-In.

 SyteLine users must have SyteLineTrans and SyteLineAutomation licenses applied.

 Infor CloudSuite users must have Transactional and Automation licenses applied.
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 Infor CloudSuite user must have the following permissions set for object type MIDDLEWARE: 

Note: See the online help for the Object Authorizations for User form for help on setting these 
authorizations.

Installing the Tool
1 Copy InforCloudSuiteProjectAddin.exe from the 

InforCloudSuiteOfficeIntegrations[version].zip file to a local folder on your client computer, for 
example C:\Temp. The computer to which you copy the file must be a client machine.

2 Double-click InforCloudSuiteProjectAddin.exe to launch the executable. 
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3 The InstallShield Wizard appears.

4 Choose the second option and change the location of the saved files if you wish. The first option 
can cause an error if you do not have appropriate permissions on the selected folder.

5 Click Next. The license agreement screen appears.

6 Once you’ve agreed to the terms, click Accept.

7 The installation process begins. You may be prompted for decisions during the installation 
process. Respond to all prompts.

8 When the screen appears that says it has been successfully installed, click Close.

Setting up the Tool
1 Open Microsoft Project.

2 Select Infor CloudSuite from the Add-in menu.

3 Choose Setup.
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4 The Infor CloudSuite IDO Web Service Setup form appears.

5 Provide the following information:

 End Point - The URL address of IDO Web service. The format looks like this: http://
servername/IDORequestService/IDOWebService.aspx.

 Use Workstation Login: Select this check box use use the workstation login. If selected, the 
Infor CloudSuite User ID and Password fields are disabled.

 Infor CloudSuite User ID - a valid Infor CloudSuite user ID.

 Password - password for the Infor CloudSuite user.

 Infor CloudSuite Config - a valid Infor CloudSuite configuration name.

 Auto Sync Out - If you select this check box, it enables you to Sync Out changes 
automatically without having to click the Sync Out button.

6 Click OK. A message appears telling you that data has been saved to the registry and that you 
must restart Project.

Note: The message telling you to restart Project appears even if you’ve not made any changes 
on the Infor CloudSuite IDO Web Service Setup form. You do not need to restart unless you’ve 
made changes on the form.

7 Click OK.
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8 Close Project and then restart Project.

Using the Tool
Now that you have installed and set up the Add-In, you can use it.

Sync In, Sync Out, and Enable Auto Sync Out

Sync In, Sync Out, and Enable Auto Sync Out are buttons found on the Infor CloudSuite toolbar that 
was added to Project when you installed the Add-In.

The items on the Toolbar are enabled or disabled based on the following conditions.

 Sync Out/Sync In are enabled only when the ’Project In Infor CloudSuite’ check box is selected

 Sync In is disabled when a valid project number is not available

 Assign Infor CloudSuite Work Resource and Assign Infor CloudSuite Resource are enabled 
only when the ’Project In Infor CloudSuite’ check box is selected and a valid Project Number is 
assigned

Sync In and Sync Out synchronize changes on the Project between Infor CloudSuite and the 
Microsoft Project client. Enable Auto Sync Out enables you to Sync Out changes automatically 
without having to click the Sync Out button.

Sync In - Brings the changes from the Infor CloudSuite Project. The following message displays 
when you click Sync In:
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Sync Out - Sends any changes made in the current project to Infor CloudSuite. The following 
message displays when you click Sync Out:

Enable Auto Sync Out - This button is a toggle button; it is either enabled or disabled. If enabled, 
every change made in Microsoft Project is updated in Infor CloudSuite immediately when you save 
the Project.

Sync In Activities

A Sync In Process:

1 Brings in new tasks, material resources, and work resources created in the Infor CloudSuite 
project.

2 Updates existing tasks, material resources, and work resources.

3 Sets Predecessor(s).
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Object Mapping:

Updating a Project Task

You can update many facets of a project task and resource including task name, status of task, and 
start and finish date based on the data from Infor CloudSuite project.

1 Marking Project Task as completed: When a task in Infor CloudSuite has completed, the add-in 
marks an MS project task that has been completed as scheduled by setting Percent Completed to 
100%.

2 Updating actual start date and finish date: When the actual start and finish date is changed in 
Infor CloudSuite, the add-in updates these changes during the Sync In process. When a duration 
is specified in Infor CloudSuite and Firm Start Date or Firm End Date is checked, the start and end 
date is calculated based on the duration. Any conflicts such as dependency or overlap that may 
arise due to changes in the start date and date have to be resolved manually.

Sync In and MS Project Layout

MS Project allows you organize your project data in various ways. You can visualize, organize, and 
adjust the project task, sub-task, and work resource that is different from the Infor CloudSuite project 
structure. To preserve the MS project format, the add-in updates only the project data from Infor 
CloudSuite and leaves format intact. The add-in does not change the position of a task or subtask, or 
the order of outline children during the Sync In. 

Infor 
CloudSuite MS Project Description

Infor 
CloudSuite 
Task

Project Task A Infor CloudSuite Task is created and managed 
as MS Project Task.

Infor 
CloudSuite 
Material 
Resource

Project Sub-Task A Material Resource is created and managed as MS 
Project Task. This is always created as a sub-task of 
a parent Infor CloudSuite Task.

Work Resource Work Resource A work resource added under a Infor 
CloudSuite task is added to the MS Project 
Resource pool and makes them available to 
assign to tasks within the project. The resource 
is assigned to its parent task by default.

Predecessor Predecessor A Predecessor task is tied to a task to indicate 
that the current task has dependencies on 
other task. Tasks with dependency 
relationships are linked automatically by the 
MS Project and the Add-In will not resolve any 
conflict that may arise due to more complex 
relationship including delay and overlap
Infor CloudSuite Industrial - Microsoft Office Integration User Guide | 119



  
When a new Task is created in Infor CloudSuite, the add-in finds a best possible delineation. To 
determine the position, the Add-in uses the task sequence, its parent task, and outline children from 
Infor CloudSuite.

Project Items Affected During Synchronization

The following Project Items are affected during synchronization:

 Project Task(s)

 Work Resources

Any user-defined work resource is ignored. You are informed about any skipped user-defined 
resource with an error message.

The progress of the Sync Out process is displayed on the toolbar.

Infor CloudSuite Project Information

The Infor CloudSuite Project Information screen collects all mandatory data required to create a 
Project in Infor CloudSuite. This screen can be accessed in the following ways:

 From the menu bar, select Infor CloudSuite > Infor CloudSuite Project Information. You can 
access this screen in this manner anytime to update project information.

 When you click the Sync Out button. This screen appears only if any required data is missing.

The screen looks like this:

 Project In Infor CloudSuite - Project data is synched only when this check box is selected.

 Project - This number is assigned by Infor CloudSuite when a project is synched or exported to 
Microsoft Project. This is a read-only field.
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 Project Name - This is the name of the project.

 Customer - Select a customer number from the drop down list.

 (Customer Name) - The name of the customer displays.

 Ship To - Select a ship to customer from the drop down list.

 (Ship To Customer Name) - The name of the ship to customer displays.

 Current Date - This date defaults from Microsoft Project Information. Any changes will update 
Microsoft Project Information.

 Start Date - This date defaults from Microsoft Project Information. Any changes will update 
Microsoft Project Information.

 End Date - This date defaults from Microsoft Project Information. Any changes will update 
Microsoft Project Information.

 Type - Select a type from the drop down list.

 Status - Select a project status from the drop down list.

 Product Code - Select a product code from the drop down list.

 Sync Out - The Sync Out button will update/create a Project in Infor CloudSuite. This button is 
enabled only when the ’Project In Infor CloudSuite’ check box is selected.  Use Sync Out from the 
Infor CloudSuite toolbar or Infor CloudSuite menu to update Project, Project Tasks, and Project 
Work Resources.

If the project number is blank, a new project is created and assigned to the project number. The 
following warning displays when you click Sync Out:

If the project number is not blank, then it will update the Project Information in Infor CloudSuite. 
The following warning displays when you click Sync Out:

 No- Closes the form.
Infor CloudSuite Industrial - Microsoft Office Integration User Guide | 121



  
Creating an Estimate Project

Choose a status of "Estimate" on the Infor CloudSuite Project Information form. Once created, the 
status field becomes disabled.

Creating a Project Task

A task is created/updated in Infor CloudSuite when you perform the Sync Out process from the menu 
or when you click the Assign Infor CloudSuite Resource button.

1 Enter a task in Microsoft Project, and then click on the Assign Infor CloudSuite Resource 
button.

2 Click the Sync Out button on the form without filling the Item details (Sync Out creates a material 
resource, if an item is selected).

3 A new Task is created in Infor CloudSuite and returns the Task Num that displays on the Task 
Num column.
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4 The Project Resource section of this form is disabled.

Assigning a Infor CloudSuite Resource

The Infor CloudSuite Project Resource screen lets you assign a material resource to a task. A 
material resource appears as sub-task in Microsoft Project. You can define a material resource as a 
sub-task by selecting a Task and then selecting Infor CloudSuite > Assign Infor CloudSuite 
Resource from the menu. Both project task and material resource can be updated using the Infor 
CloudSuite Project Resource screen.

You can move the material resources under a different task by using Indent or Outdent functions. 
After moving a material resource under a different task, you must execute the Sync Out from the Infor 
CloudSuite Project Resource screen to create the material resource under the new project task in 
Infor CloudSuite. However, the material resources created earlier under the previous task are not 
deleted. You must delete them manually from Infor CloudSuite.

Open the Infor CloudSuite Project Resource screen in one of two ways:

 From the menu bar select Infor CloudSuite > Assign Infor CloudSuite Resource.

OR

 On the Infor CloudSuite toolbar, click the Assign Infor CloudSuite Resource button.
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The screen looks like this:

Note: The Task Details section is enabled when you come from a project task. The Project Resources 
section is disabled at this time. The Project Resources section is enabled when you come from the 
material resource. The Task Details section is disabled at this time.

 Task Num - This is the number of the task.

 (Task Name) - This is the name of the task.

 Task Date - This is the date the task was entered into Infor CloudSuite either on the Estimate 
Project Tasks form, the Project Tasks, or the Project Resources form.

 Task Status - You can change the status by selecting a different from the drop-down list. 
Changes are updated in Infor CloudSuite during the Sync Out process.

 Start Date - Defaulted from the Microsoft project task start date.

 End Date - Defaulted from the Microsoft project task end date.

 Item - Select an item from the drop down list. The description appears automatically upon item 
selection. The item cannot be changed for an existing resource.

 Description - The description of the item displays.

 Sequence - The sequence number displays. This field is read only.

 Type - Choose the type from the drop down list.

 Cost Code - Choose the cost code from the drop down list.

 Due Date - Enter a due date.

 Qty - Enter the quantity.

 Whse - Choose the warehouse from the drop down list.

 Projected Date - This field is read only. The date comes from the Project Resources form in Infor 
CloudSuite.

 UOM - Choose the unit of measure from the drop down list.
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 Sync Out - Sync Out creates a new task or material resource in Infor CloudSuite. An update is 
performed for the existing item. The following message displays when you click Sync Out.

Assigning Infor CloudSuite Work Resources

Infor CloudSuite work resources are defined on the Project Resource Type form in Infor CloudSuite. 
Included as defaults are employee, user, and vendor. You can add more types on that form.

You can assign these work resources to a project task using the Assign Infor CloudSuite Work 
Resources screen.

Any resources assigned by this form are added to the Microsoft Project Resources.

Select Infor CloudSuite > Assign Infor CloudSuite Resource from the menu bar to open the Infor 
CloudSuite Project Work Resource screen.

 Task Num - The number of the task displays. This field is read only.

 (Description) - The description of the task number displays. This field is read only.

 Sequence - Enter a sequence to edit the existing sequence value or leave blank to create a new 
sequence value.

 Work Resource Type - Select a work resource type from the drop down list.

 Work Resource Name - Select a work resource name from the drop down list. The drop-down is 
filtered based on the selection in the Work Resource Type field.
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 Sync Out - Click this button to create a new work resource. Update is performed on the existing 
resource. The following message displays when you click Sync Out:

Summary Task Information Resources Tab

In Microsoft Project, open the Summary Task Information screen.

On the Resources tab of this screen, you can select an existing work resource.  The selected work 
resource is added to Infor CloudSuite during the Sync Out process. If you create or select a resource 
which is not a Infor CloudSuite Resource, it is excluded during the Sync Out process.
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Examples

Creating a New Project in Infor CloudSuite Using Microsoft Project 
Client

1 Open the Microsoft Project Client. 

2 From the menu select Infor CloudSuite > Infor CloudSuite Project Information.

If the Infor CloudSuite menu is not available, see the installation and setup section of this guide.

3 Select the ‘Project In Infor CloudSuite’ check box. 

4 Enter a project name.

5 Select a customer and ship to.

6 Select a type.

7 Select the status. 

8 Select a product code.

9 Change the current date, start date, and end date if needed.

10 Click the Sync Out button, and then click Yes for the warning message. A new project has been 
created in Infor CloudSuite and returns the next project number on the project column.

11 To verify that the new project is in Infor CloudSuite, open the Projects form in Infor CloudSuite and 
filter for the project number returned to the above column.
Infor CloudSuite Industrial - Microsoft Office Integration User Guide | 127



  
Creating a New Project Task in Infor CloudSuite Using Microsoft 
Project Client

Create a Single Task

1 Enter a task name (Task 1) on the Microsoft Project Client.

2 Click Assign Infor CloudSuite Resource on the toolbar.

3 Select a Status of ‘Active’.

4 Click the Sync Out button, and the click Yes at the prompt. 

5 This creates a new task under the project created in step one and returns the Task Num. 

Create a Multiple Task

1 Enter Task 2 and Task 3 on the Microsoft Project Client. 

2 Click the Sync Out button on the toolbar, and then click Yes at the prompt. 

3 The Sync Out process creates two new tasks in Infor CloudSuite and returns the Task Numbers. 

4 To verify the task number, select Task 2, and then click Assign Infor CloudSuite Resource. The 
task number shows the new number created in Infor CloudSuite. 

5 To verify the new project tasks in Infor CloudSuite, open the Project Tasks form in Infor 
CloudSuite and filter for the project number created in the first step.

Creating a New Resource (Material) in Infor CloudSuite Using 
Microsoft Project Client

Infor CloudSuite Project Tasks and Resources are treated as tasks in Microsoft Project Client. The 
Add-In will flag the task to distinguish between tasks and resources.

1 Select an existing task from the Microsoft Project client. This task should have a valid Infor 
CloudSuite task number assigned using the Sync Out process. 

2 Insert a new task. Enter a short name for the task as this task name is overwritten by the Add-In 
with the actual item later.

3 Indent the task under the selected task.  A material resource can be created only as a child for 
valid Infor CloudSuite task.

4 Click on Assign Infor CloudSuite Resource from the toolbar. 

5 Enter the Item and other details as required.

6 Click the Sync Out button and then click Yes at the prompt. 
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7 This creates a resource in Infor CloudSuite under the selected task and displays as shown below.

8 To verify the new project resources in Infor CloudSuite, open the Project Resources form in Infor 
CloudSuite and filter for the project number created in the first step.

Creating a New Work Resource (Employee, User, etc.) in Infor 
CloudSuite Using Microsoft Project Client

1 Select a task in Microsoft Project Client with a valid task num.

2 Click Assign Infor CloudSuite Work Resource in the Infor CloudSuite toolbar. The Infor 
CloudSuite Work Resource screen appears with the selected task number and name on the 
header.

3 Enter a sequence number or leave blank to get the next number assigned by the system.

4 Select a work resource type such as employee or user.

5 Select a work resource name. Overwrite this name if required.

6 Click the Sync Out button, and then click Yes at the prompt. This creates a new work resource 
name and assigns it to the selected task. In the example below, the employee name ‘Danny’ is 
assigned to the task Task 2.

7 To verify the new work resources in Infor CloudSuite, open the Project Tasks form, filter the 
selected task, and then click on the MS Work Resources tab.

Assigning Existing Work Resources to Different Tasks Using 
Microsoft Project Client

1 Double-click the existing task.

2 The Microsoft Task Information screen appears. Select the Resources tab.
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3 Select a resource name from the drop-down list.

Note: A user created resource is not included during the Sync process.
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